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1 Welcome to COPA-DATA help 

ZENON VIDEO TUTORIALS 

You can find practical examples for project configuration with zenon in our YouTube channel 

(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an 

initial insight into working with different zenon modules. All tutorials are available in English. 

 

GENERAL HELP 

If you cannot find any information you require in this help chapter or can think of anything that you 

would like added, please send an email to documentation@copadata.com. 

 

PROJECT SUPPORT 

You can receive support for any real project you may have from our customer service team, which 

you can contact via email at support@copadata.com. 

 

LICENSES AND MODULES 

If you find that you need other modules or licenses, our staff will be happy to help you. Email 

sales@copadata.com. 
 

2 Tools 

A range of tools support you for the management, analysis and configuration of zenon: 

 3D Integration: 

In this zenon application, 3D CAD files can be linked to zenon project configurations in a 

graphical user interface. The project configuration is displayed in zenon Runtime with a 

zenon WPF element. 

You can find detailed documentation, project configuration notes and information on 

operation in zenon Runtime in the 3D integration manual. 

 Diagnosis Viewer (on page 7): Allows zenon LOG files to be read and configured. 

https://www.copadata.com/tutorial_menu


Diagnosis Viewer 

 

7 | 142 

 

 

 GIS Integration: 

This tool makes it possible to draw objects in geographical relationships and to link these 

objects to zenon ALC information, variables and functions. 

The display in zenon Runtime visualizes ALC project configurations with selectable map 

providers. 

You can find detailed documentation, project configuration notes and information on 

operation in zenon Runtime in the GIS integration manual. 

 Keyblock Runtime Start (on page 56):  

Starts zenon Runtime and at the same time blocks all Windows system keys. 

 Online updating of the zenon help (on page 47):  

Allows online updating of the zenon help. 

 Project Translation Interface:  

Tool for the translation of zenon language files. Opens or saves data for the zenon Language 

Translation Wizard. With this, projects can be imported into or exported out of zenon. 

 Startup Tool (on page 67):  

Makes it possible to start the Editor and Runtime with certain parameters, to administer 

different zenon versions on one computer, to administer SQL instances and to define 

languages for Editor and Runtime. 

 System Information Collector (on page 119):  

Reads system information and zenon information, displays it in an output window and saves 

it as a ZIP file. 

 COPA-DATA PRP (on page 126):  

Allows the operation of a hardware-redundant zenon network via PRP communication. 

Note: PRP communication requires a valid zenon license on the computer. 

The following are available for zenon Logic: 

 zenon Logic Runtime Manager: Administer all stand-alone/manual-start zenon Logic Runtime 

projects on your computer. 

The documentation for this tool is part of the zenon Logic documentation. 
 

3 Diagnosis Viewer 

All zenon modules such as Editor, Runtime, drivers, etc. as well as zenon Analyzer write messages to a 

joint log file. These can be read and configured with the Diagnosis Viewer program. It allows the 

reading of existing LOG files, online logging, saving of the current view, parameterizing the Diagnosis 

Viewer and the Diagnosis Server. 
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START THE DIAGNOSIS VIEWER 

The Diagnosis Viewer is installed in the folder: %Program Files (x86)%\Common 

Files\COPA-DATA\STARTUP. Call it up under: 

 Windows 8: Enter "Diagnosis Viewer" on the desktop for Apps 

 Windows 7: Start/All Programs/zenon/Version Independent Tools -> Diagnosis 

Viewer.  

The Diagnosis Viewer is only available in English. 

USING IPV6 

The Diagnosis Server also works with Diagnosis Clients which addresses via IPv6 addresses. For this 

the format of the log file has been adapted. The Diagnosis Viewer only reads the new format of the 

log files. If files from older zenon versions are opened (or vice versa), the IP address of the Diagnosis 

Client is not displayed correctly. 

DRIVER ANALYSIS 

zenon driver log all errors in the LOG files.LOG files are text files with a special structure. The default 

folder for the LOG files is subfolder LOG in the folder ProgramData. For example: 

%ProgramData%\COPA-DATA\LOG. 

Attention: With the default settings, a driver only logs error information. With the Diagnosis Viewer 

you can enhance the diagnosis level for most of the drivers to "Debug" and "Deep Debug". With this 

the driver also logs all other important tasks and events. 

In the Diagnosis Viewer you can also: 

 Follow newly-created entries in real time 

 customize the logging settings 

 change the folder in which the LOG files are saved 

Note: 

1. The Diagnosis Viewer displays all entries in UTC (coordinated world time) and not in local 

time. 

2. The Diagnosis Viewer does not display all columns of a LOG file per default. To display more 

columns activate property Add all columns with entry in the context menu of the column 

header. 

3. If you only use Error-Logging, the problem description is in the column Error text. For other 

diagnosis level the description is in the column General text. 
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4. For communication problems many drivers also log error numbers which the PLC assigns to 

them. They are displayed in Error text or Error code or Driver error parameter (1 and 2). Hints 

on the meaning of error codes can be found in the driver documentation and the 

protocol/PLC description. 

5. At the end of your test set back the diagnosis level from Debug or Deep Debug. At Debug 

and Deep Debug there are a great deal of data for logging which are saved to the hard drive 

and which can influence your system performance. They are still logged even after you close 

the Diagnosis Viewer. 

Attention 

In Windows CE errors are not logged per default due to performance reasons. 

 
 

3.1 General 

The zenon Diagnosis System logs error messages from zenon and zenon Analyzer. It consists of three 

parts: 

 Diagnosis Server (on page 22): local or defined in zenon6.ini defined zenLogSrv 

 Diagnosis Clients (on page 25): all modules, drivers, services, etc. which write messages 

 Diagnosis Viewer (on page 28): Analysis program 

VERSIONS 

From version zenon 7.00 on the service zenLogSrv is used instead of the zenSysSrv for the diagnosis 

system. That means: 

 Diagnosis systems up to version 6.51 and from version 7.00 are each compatible among 

themselves. 

 The diagnosis mechanism of zenon 6.51 SP0 and zenon 7.00 SP0 are not compatible. 

Compatibility Diagnosis Server 6.51 SP0 

and earlier 

Diagnosis Server 7.00 

SP0 and higher 

Diagnosis Client 6.51 SP0 and earlier compatible incompatible 

Diagnosis Viewer 6.51 SP0 and earlier compatible incompatible 

Diagnosis Client 7.00 SP0 and higher incompatible compatible 

Diagnosis Viewer 7.00 SP0 and higher incompatible compatible 

With the Diagnosis Viewerversion 7.00 SP0 and higher you can open log files which were created by 

Diagnosis Server version 6.51 SP0 (or earlier). It does not work the other way round. 
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DEFAULT PORTS 

 Version 7 and higher: 50780 (port of service zenLogSrv) 

 up to 6.51: 1101 (port of service zenSysSrv) 

If the port cannot be opened, the service closes itself. 

Attention 

If the port to which the Diagnosis Viewer should connect is closes, then it is tried 

to start the local Diagnosis Server. This makes sure that local logging is carried 

out if no Diagnosis Server is available in the network. 

MEMORY OCCUPANCY 

Service zenLogSrv buffers log entries until they can be written in the LOG file. If the memory 

consumptions increases continuously by zenLogSrv, it is an indicator that the LOG file cannot be 

written. 
 

3.2 Topology of the diagnosis system 

The topology of the diagnosis system differs  for versions up to 6.51 SP0 and from 7.00 SP0 on. 

TOPOLOGY BEFORE ZENON 7.00 SP0 

The diagram displays all possible connections for which zenSysSrv is responsible. Each arrow 

represents a network connection between the applications. All applications connect to the zenSysSrv 

on port 1101 regardless of whether Client and Server are on the same computer or communicate with 

each other via a network. 

 

1. The Editor sends log entries, commands and data of the Remote Transport to zenSysSrv. 

zenSysSrv sends the configuration of the Diagnosis Client (Editor, Runtime, driver, zenon 

Web Server, zenon Web Client, etc.) and the Remote Transport data to the Editor. 



Diagnosis Viewer 

 

11 | 142 

 

 

2. The Diagnosis Viewer sends diagnosis commands, diagnosis configurations and log entries to 

zenSysSrv. zenSysSrv sends diagnosis data and the Diagnosis Clientconfiguration to the 

Diagnosis Viewer. 

3. zenSysSrv sends the Diagnosis Client configuration to the Diagnosis Clients. The Diagnosis 

Clients send log entries to zenSysSrv. 

zenSysSrv reacts correspondingly to each incoming message: 

 Log entries are written in log files. 

 Remote Transport commands (start Runtime, write/read back data, etc.) are executed. 

 Diagnosis commands (set Server/Client configuration, start online logging, etc.) are executed. 

TOPOLOGY AS OF ZENON 7.00 SP0 

The diagram displays all possible connections for which zenSysSrv and zenLogSrv (as of version 7.00 

SP0) are responsible. Each arrow represents a network connection between the applications. All 

applications connect to zenLogSrv on port 50780. The editor connects to zenSysSrv on port 1101. It is 

regardless of whether Client and Server are on the same computer or communicate with each other 

via a network. 

 

1. The Editor sends commands and data of the Remote Transport to zenSysSrv. zenSysSrv 

sends data of the Remote Transport to the Editor. 

2. The Editors send log entries to zenLogSrv. zenLogSrv sends the Diagnosis Client 

configuration to the Editor. 

3. The Diagnosis Viewer sends diagnosis commands, diagnosis configurations and log entries to 

zenLogSrv. zenLogSrv sends diagnosis data and the Diagnosis Client configuration to the 

Diagnosis Viewer. 

4. The zenSysSrv sends LOG entries to zenLogSrv. zenLogSrv sends the configuration of the 

Diagnosis Clients to zenSysSrv. 

5. zenLogSrv sends the configuration of the Diagnosis Clients to the Diagnosis Clients. 

Diagnosis Clients send log entries to zenLogSrv. 
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The zenSysSrv reacts to incoming Remote Transport commands.  

The zenLogSrv reacts to incoming diagnosis commands and log entries 

EXAMPLE 

IN an environment with a central Diagnosis Server the Runtime is started on a device. Based on the 

Runtime version the configuration is read from zenon6.ini. Versions before 7.00 SP0 read entry 

LOG_CONFIG from [SYS_REMOTE], later versions read this entry from [LOGGING_SYSTEM]. This 

configuration is used to establish a diagnosis connection. (For details see Standard procedure (on 

page 12).) Each additional component loaded by the Runtime (driver, zenNetSrv, etc.) also establish a 

diagnosis connection. 
 

3.3 Procedure 

As default only error messages (errors) are sent from the Clients to the Diagnosis Server. 

The Diagnosis Server saves the received messages in TXT files with a special structure (on page 44). 

The default folder for the log files is the LOG subfolder in the %ProgramData% folder.For example: 

%ProgramData%\COPA-DATA\LOG. 

You can find further information in the installation and updates manual in the File structure chapter. 

Note: Under Windows CE error messages are also not created per default due to resource issues. 

In order to report not only error messages to the Diagnosis Server but also other information 

important for the diagnosis, the according settings have to be defined for the Client (on page 25). 

You can also configure the behavior of the Server (on page 22). 

CONFIGURATION 

The configuration of the connection is done in zenon6.inI (on page 13) divided in: 

 Diagnosis Clients 

 Diagnosis Server 

 Versions to make sure that the configuration of the versions does not affect each other 

The configuration of the Diagnosis Viewer (on page 28) also enables you to configure settings for the 

connection: 

 Settings of the server (on page 23) 

 Connection setting for Diagnosis Server connection (on page 30) 

 Diagnosis Client (on page 25) 

 Diagnosis Viewer analysis program (on page 28) 

We recommend to do the configuration of the connection for Server and Client via zenon6.ini. 
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PROCEDURE 

The Diagnosis Server is: 

 a service at the PC.  

The service starts automatically when the operating system boots. The local service can only 

be started once. 

 an application under CE.  

Under CE only one process can use the port. Additionally started processes terminate 

themselves as the port cannot be opened. If the local configuration of the Diagnosis Servers 

is set under CE in such a way that only the user interface is displayed (INIT=2), several 

processes could emerge by the Diagnosis Clients trying to start the local Diagnosis Server 

As soon as a Diagnosis Client gets active, the following steps are carried out: 

1. The Diagnosis Client reads and uses the configuration from zenon6.ini. If no configuration is 

available in zenon6.ini, the default configuration (Diagnosis Server=localhost:50780) is used. 

2. The Diagnosis Client attempts to establish a connection to the Diagnosis Server: 

Establishing successful: 

a) The diagnosis connection has been established and the log entries are sent. 

Establishing failed: 

b) The Diagnosis Client tries to start and use the local Diagnosis Server.  

On a PC it tries to start the service.  

Under CE it tries to create the process. 

c) The Diagnosis Client attempts to establish a connection to the local Diagnosis Server. If it 

succeeds, the diagnosis connection is established and the log entries are sent. 

If it fails, no log entries are created. 

 
 

3.3.1 Entries in zenon6.ini 

zenSysSrv and zenLogSrv are configured in zenon6.ini. At this it is differentiated between version 7.00 

and up and versions 6.51 and earlier. With this you can configure old and new Diagnosis Clients and 

Diagnosis Server independent of each other on one device. For example, the LOG entries of old 

Diagnosis Clients are diverted, without the LOG entries of new clients being affected. 

DIAGNOSIS SERVER PRIOR TO VERSION 7.00 SP0 

INI entry Description 

[SYS_REMOTE]   Section in zenon6.ini. 
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INI entry Description 

Contains parameters for zenSysSrv (Remote Transport and Diagnosis 

Server). 

LOGDirectory= Defines folder for the LOG files. 

If there is no entry, the LOG folder in the %ProgramData% folder is 

used by default. 

Example:  

LOGDirectory= %ProgramData%\COPA-DATA\zenon760\LOG 

CONFIG= Configuration string for the Diagnosis Server and zenSysSrv . Remote 

Transport and the diagnosis system use the same server configuration 

up to and including version 6.51 SP0. The string consists of the 

following parts: 

DEVICE=[Device];HOST=[Hostname];PORT=[Port];TIMEOUT=[Timeou

t] 

 DEVICE: Sets the communication type used.  

TCP/IP and serial are available. 

 HOST: is set to the computer name of the Diagnosis Server. 

 PORT: states the port to be used. 

 TIMEOUT: Provides the timeout time for the connection is 

seconds. 

 BAUD: provides the connection speed of a serial connection. 

PC configuration: 

 DEVICE=TCP/IP 

 HOST=localhost 

 PORT=1101 

 TIMEOUT=10 

CE configuration: 

 DEVICE=COM1 

 BAUD=115200 

LOGMinFreeDiskSpace

= 

Defines minimum memory (in MB) that must be available on the hard 

drive. LOG files are deleted before this value is gone below. 

Default: 1024 

LOGMaxUsedDiskSpace Defines the maximum memory on the hard drive in MB used for LOG 
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INI entry Description 

= files. LOG files are deleted if this value is exceeded. 

Default: 1024 

LOGMinUsedDiskSpace

= 

Defines memory on the hard drive (in MB) that is used even if there 

are no LOG files. 

Default: 5 

LOGLogLifeTime= Defines the lifecycle of the LOG files in seconds. Older LOG files are 

deleted. 

Default: 1209600 (corresponds to 14 days) 

LOGImageCnt= Defines the number of LOG entries, after which all incremental LOG 

files are written. 

 0: inactive (default) 

LOGLogUpdateTime= Number of milliseconds, after which the LOG entries received are 

written to a LOG file. 

Default: 2000 

LOGMaxBufferedRecs= Defines the number of LOG entries that are buffered if they cannot be 

written to files. 

Default: 10240 

LOGMaxLogFileSize= Maximal size of a log file in bytes. If a log file reaches this size, it is 

closed and a new log file is created. 

Default: 5242880 (corresponds to 5 MB) 

LOGCheckDiskTime= Defines the interval in seconds, in which the memory occupied by 

LOG files is checked. 

Default: 60 

INIT= Action when starting the application with Windows CE: 

 0: end immediately 

 1 (or other value greater than 2): Open Listening Port and 

minimize in system tray 

 2: only display surface 

Default: 1 

Note: As part of the separation of zenSysServ and zenLogServ for 
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INI entry Description 

zenon 7.00, this default value was also changed for other versions. 

The default value was previously 2. 

DIAGNOSIS SERVER AS OF VERSION 7.00 SP0 

INI entry Description 

[LOGGING_SYSTEM] Section in zenon6.ini. 

Contains parameters for Diagnosis Server. Only affects zenLogSrv and 

has no effect on zenSysSrv. 

LOGDirectory= Defines the folder for the LOG files. 

If there is no entry, the following is used: 

 The path extracted from the Registry,  

z. B. %ProgramData%\COPA-DATA\LOG 

 the LOG folder in the %ProgramData%folder of the zenLogSrv, 

if no path is defined in the registry, 

e.g. %ProgramData%\COPA-DATA\zenon760\LOG 

CONFIG= Configuration string for the Diagnosis Server. The string consists of 

the following parts: 

DEVICE=TCP/IP;HOST=[Hostname];PORT=[Port];TIMEOUT=[Timeout] 

 DEVICE: Sets the communication type used and must always 

be set to TCP/IP 

 HOST: is set to the computer name of the Diagnosis Server. 

 PORT: states the port to be used. 

 TIMEOUT: Provides the timeout time for the connection is 

seconds. 

Configuration: 

 DEVICE=TCP/IP 

 HOST=localhost 

 PORT=50780 

 TIMEOUT=10 

LOGMinFreeDiskSpace

= 

Defines minimum memory (in MB) that must be available on the hard 

drive. LOG files are deleted before this value is gone below. 

Default: 1024 
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INI entry Description 

LOGMaxUsedDiskSpac

e= 

Defines the maximum memory on the hard drive in MB used for LOG 

files. LOG files are deleted if this value is exceeded. 

Default: 1024 

LOGMinUsedDiskSpac

e= 

Defines memory on the hard drive (in MB) that is used even if there 

are no LOG files. 

Default: 5 

LOGLogLifeTime= Defines the lifecycle of the LOG files in seconds. Older LOG files are 

deleted. 

Default: 1209600 (corresponds to 14 days) 

LOGImageCnt= Defines the number of LOG entries, after which all incremental LOG 

files are written. 

Default: 0 

LOGLogUpdateTime= Number of milliseconds, after which the LOG entries received are 

written to a LOG file. 

Default: 2000 

LOGMaxBufferedRecs

= 

Defines the number of LOG entries that are buffered if they cannot be 

written to files. 

Default: 10240 

LOGMaxLogFileSize= Maximal size of a log file in bytes. If a log file reaches this size, it is 

closed and a new log file is created. 

Default: 5242880 (corresponds to 5 MB) 

LOGCheckDiskTime= Defines the interval in seconds, in which the memory occupied by 

LOG files is checked. 

Default: 60 

INIT= Action when starting the application with Windows CE: 

 0: end immediately 

 1 (or other value greater than 2): Open Listening Port and 

minimize in system tray 

 2: only display surface 

Default: 1 
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DIAGNOSIS CLIENT PRIOR TO VERSION 7.00 SP0: 

INI entry Description 

[SYS_REMOTE] Section in  zenon6.ini. 

Contains parameters for Diagnosis Client. 

LOG_CONFIG= A configuration string for the Diagnosis Client is stored here. The 

string consists of the following parts: 

DEVICE=TCP/IP;HOST=[Hostname];PORT=[Port];TIMEOUT=[Timeout] 

 DEVICE: Sets the communication type used and must always 

be set to TCP/IP 

 HOST: is set to the computer name of the Diagnosis Server. 

 PORT: states the port to be used. 

 TIMEOUT: Provides the timeout time for the connection is 

seconds. 

Configuration: 

 DEVICE=TCP/IP 

 HOST=localhost 

 PORT=1101 

 TIMEOUT=10 

DIAGNOSIS CLIENT AS OF VERSION 7.00 SP0 

INI entry Description 

[LOGGING_SYSTEM] Section in zenon6.ini. 

Contains parameters for Diagnosis Client. 

LOG_CONFIG= A configuration string for the Diagnosis Client is stored here. The 

string consists of the following parts: 

DEVICE=TCP/IP;HOST=[Hostname];PORT=[Port];TIMEOUT=[Timeout] 

 DEVICE: Sets the communication type used and must always 

be set to TCP/IP 

 HOST: is set to the computer name of the Diagnosis Server. 

 PORT: states the port to be used. 

 TIMEOUT: Provides the timeout time for the connection is 

seconds. 
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INI entry Description 

Configuration: 

 DEVICE=TCP/IP 

 HOST=localhost 

 PORT=50780 

 TIMEOUT=10 

 

NOTE: 

INIT UNDER CE 

Under Windows CE we urgently recommend to not set entry INIT= (in section [LOGGING_SYSTEM] 

or [SYS_REMOTE]) to value 2. 

Reason: The value 2 means that both SysSrvCE and LogSrvCE only display the user interface and do 

not open the listening port.  

If now a Diagnosis Client wants to establish a connection, it will fail. As in this case the Diagnosis Client 

start process LogSrvCE and the process does not open the port, each Diagnosis Client starts such a 

process. This leads to several parallel LogSrvCE processes and to a delay in starting the Diagnosis 

Clients as it waits for the timeout of the connection while establishing the diagnosis connection. 

ZENLOGSRV ON A SYSTEM WITH DIFFERENT ZENON VERSIONS 

If zenLogSrv is used for a system with different zenon versions as a central local Diagnosis Server, the 

LOG_CONFIG entry in the [SYS_REMOTE] section must be as follows: 

DEVICE=TCP/IP;HOST=localhost;PORT=5780;TIMEOUT=10 

Reason: Older clients use the zenLogSrv as a result of this entry (instead of the obsolete zenSysSrv 

service) as a Diagnosis Server. New clients use the current zenLogSrv service by default. This service is 

automatically started when the system is started. 

Attention: If the port cannot be reached, older clients start zenSysSrv and retry connecting to it. 

 
 

3.3.2 Windows CE 

Under Windows CE the Diagnosis Server is started as an application. 
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At the configuration (on page 13) of the connection consider the recommendation for parameter 

INIT: 

Under Windows CE we urgently recommend to not set entry INIT= (in section [LOGGING_SYSTEM] 

or [SYS_REMOTE]) to value 2. 

Reason: The value 2 means that both SysSrvCE and LogSrvCE only display the user interface and do 

not open the listening port.  

If now a Diagnosis Client wants to establish a connection, it will fail. As in this case the Diagnosis Client 

start process LogSrvCE and the process does not open the port, each Diagnosis Client starts such a 

process. This leads to several parallel LogSrvCE processes and to a delay in starting the Diagnosis 

Clients as it waits for the timeout of the connection while establishing the diagnosis connection. 

USER INTERFACE UNDER CE 

TRANSPORT SERVICE (ZENSYSSRV) 

 

Parameter Description 

Start Opens the Listening port and enables zenSysSrv  to receive 

Remote Transport commands. 

Browse Opens the dialog for browsing the file system. 

Stop Terminates the receiving of Remote Transport commands and 

closes the Listening port. 

Configuration Selection of an existing server configuration from drop-down list. 

New connections cannot be configured. See section Entries in 

zenon6.ini (on page 13) for the configuration of the connection.  

Available are: 

 Configuration from  zenon6.ini 

 Default configuration for TCP/IP 

 Default configuration for COM1 to COM4 

Hide Minimizes the user interface into the task bar. 
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Parameter Description 

Exit Terminates the application and closes the Listening port if 

necessary. 

X  

(button top right) 

Minimizes the user interface into the task bar. 

LOGGING SERVICE (ZENLOGSRV) 

 

Parameter Description 

Start Opens the Listening port and enables zenLogSrv to receive log 

entries. 

Stop Terminates the receiving of log entries and closes the Listening 

port. 

Configuration Selection of an existing configuration from drop-down list. New 

connections cannot be configured. See section Entries in 

zenon6.ini (on page 13) for the configuration of the connection.  

Available are: 

 Configuration from zenon6.ini 

 Default configuration for TCP/IP 

Hide Minimizes the user interface into the task bar. 

Exit Terminates the application and closes the Listening port if 

necessary. 

X  

(button top right) 

Minimizes the user interface into the task bar. 
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3.4 Diagnosis Server 

The Diagnosis Server: 

 Creates and manages log files. 

 The Server is: 

 implemented from zenon 7.00 on as zenLogSrv 

 up until zenon 6.51 integrated in the zenSysSrv. 

 The configuration of the server is read from the zenon6.ini (on page 13). 

 The server writes the received log data into the log file. 

 The saving location for the files has to be configured. Standard: 

%ProgramData%\COPA-DATA\LOG\ 

 Log files are named after the following fashion LOG<YYMMTThhmmss>.txt. 

 The server is multi client able. Several evaluations can connect to the server simultaneously. 

 It is possible to connect to the server online, to see the current logging messages. 

 It is possible to connect to Diagnosis Server different than the local and to execute the same 

tasks (configuring server, configuring clients, online logging) as on the local server. 

 The parameters of the current server (with which the Diagnosis Viewer is connected) can be 

modified. If a modification of another Diagnosis Server is needed, the server connection can 

be changed in the menu under File – Connect to…. . 

 The menu entry Settings – Server configuration is only available, if online logging is not used 

at the moment. 

 
 

3.4.1 System integrity monitoring 

At the start of the Runtime a monitoring thread with high priority is also started. The monitoring 

thread checks critical parameters every ten seconds and writes corresponding warnings or errors in 

module Supervisor of the Diagnosis Server. 

The following parameters are monitored. 

Parameter Limit value 

Warning threshold for used handles > 5000 

Error threshold for used handles > 9000 

Warning threshold for used GDI objects > 5000 

Error threshold for used GDI objects > 9000 
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Parameter Limit value 

Warning threshold for CPU use for the main thread > 70 % 

Error threshold for CPU use for the main thread > 90 % 

Warning threshold for total CPU use > 70 % 

Error threshold for total CPU use > 90 % 

Warning threshold for free main memory < 30 % 

Error threshold for free main memory < 10 % 

Warning threshold for OnTimer in the main frame > 1000 ms 

Error threshold for OnTimer in the main frame > 5000 ms 

 
 

3.4.2 Settings of the server 

The Diagnosis Server can be configured via entries in file zenon6.ini or via dialog Server configuration 

in the Diagnosis Client. We recommend to do the settings in file zenon6.ini. 

CONFIGURATION VIA ZENON6.INI 

See section Entries in zenon6.ini (on page 13). 

CONFIGURATION VIA DIALOG 

To configure the Diagnosis Server via the dialog: 

1. start the Diagnosis Viewer 

2. open entry File Connect to... (on page 30). 

3. configure the desired Server 

(Take care of the correct port selection depending on the version!) 

4. open entry Settings -> Server configuration 

5. configure the events which should be logged 

6. Close the dialog by clicking on OK. 

Note: All changes are written to zenon6.ini when the dialog is confirmed. 
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Configuration of the events which should be logged by the Diagnosis Viewer: 

 

Parameter Description 

Modules Selection of the modules which you want to configure. 

Messagelevel Selection of the events to be logged. 

Default: ERRORS 

LOGImageCnt Number of records, after which all incremental fields will be written.  

Default: 0 (inactive) 

LOGMinFreeDiskSpace It is continuously checked, if less than the configured minimal free 

disk space is available. The oldest log files are deleted. Minimal free 

disk space in MB, before log files are deleted.  

Default: 1024 MB 

LOGMaxUsedDiskSpac

e 

Maximal used disk space for the LOG file in MB.  

Default: 1024 MB 

LOGMinUsedDiskSpac

e 

Minimal used disk space in MB independent whether 

LOGMinFreeDiskSpace is under-run.  

Default: 5 MB 

LOGLogUpdateTime Time in ms, after which the received entries are saved.  

Default: 2000 ms 

LOGMaxBufferedRecs The server buffers the contents of all incremental log fields for 

diverse applications, in order to be able to write images of them 

into the LOG file. With the start of a log file and after configurable 

number of log entries a complete image for all addresses is written 

into the log file.  

Received data are written to the log files. The entry is done via 

temporary buffer. It can be configured whether the data should be 
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Parameter Description 

written immediately or delayed.  

Number of buffered entries if they cannot be saved.  

Default: 10240 

LOGMaxLogFileSize The server writes the received log data into the log file. If this log 

file reaches the configured size, a new file is started.  

Maximal size of a single log file in bytes.  

Default: 5 MB 

LOGDirectory Folder in which the log files are written.  

Default: %ProgramData%\COPA-DATA\LOG\ 

LOGLogLifeTime It is continuously checked, if the lifetime of the log files is exceeded.  

The oldest log files are deleted.  

Number of seconds to keep the log files.  

Default: 14 days 

LOGCheckDiskTime Time in sec, in which the used disk space id checked.  

Default: 60 s 

Message level for all 

modules 
Settings are taken over for all modules. 

Default values Restore default settings. 

Accept Take over settings for this module. 

Cancel Discards changes and closes dialog. 

OK Applies changes and closes dialog. 

 
 

3.5 Diagnosis Client 

Each program that creates log entries is a Diagnosis Client. These log entries are sent to the Diagnosis 

Server via TCP/IP. Server computer and port are read - dependent on the used version - from the 

local zenon6.ini (on page 13) and contacted. If the connection fails the following procedure is carried 

out cyclically: 

 If the Diagnosis Server cannot be reached, a attempt to reconnect is made every 500 ms. 

 If no connection could be established after half the timeout time, the system tries to start the 

service zenSysSrv or zenLogSrv. 

The settings are configured with the LOG_CONFIG= entry in the [SYS_REMOTE] section (up to 6.51) 

or [LOGGING_SYSTEM] (from 7.00). 
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CONFIGURATION OF DIAGNOSIS CLIENT 

To configure the Diagnosis Client via the dialog: 

1. Start the Diagnosis Viewer. 

2. Open the entry Settings -> Client configuration 

(only available if logging is inactive) 

3. Highlight a Client. 

4. Click on List of parameters. 

5. The dialog for configuration is opened 

6. Configure the Client. 

7. Close the dialog by clicking on OK. 

8. Repeat the procedure for other Clients if necessary 

CLIENT LIST 

 

Parameter Description 

Clients Lists all available Clients. 

Refresh Updates the list of the Clients. 

List of parameters Opens the dialog for configuring the selected Client. 

Close Closes the dialog. 
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CONFIGURE CLIENT 

 

Modules that can be selected: 

Module Description 

Modules Selection of the modules which you want to configure. 

The list is made up of default modules and modules dependent on 

the respective client. 

 General:General messages 

 Net:Network messages 

 Proxy: Messages of the zenon Proxy 

 Db: Messages from ZenDbSrv 

 SysSrv: Messages from ZenSysSrv 

 Driver: Messages from a driver 

 LOG: Messages from logging 

 SAT: SICAM 230 specific messages 

Messagelevel Type of information which should be logged. 

All Selects all. 

None Deselects all. 

Message Level for all 

Modules 
Assigns highlighted message levels to all modules. 

Max Buffered records Number of entries to be buffered if there is no connection to the 

Diagnosis Server.  
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Module Description 

Default: 256 

OK Applies all changes and closes dialog. 

Cancel Discards all changes and closes the dialog. 

Accept Applies all changes. The dialog remains open. 

Default values Enters the defaults. 

 
 

3.6 Diagnosis Viewer - Analysis Program 

The Diagnosis Viewer is used to display the LOG data. It connects to the Diagnosis Server in order to 

display data online or read back historic log files. Log files contain not only the log data, additional 

information which is important for the analysis such as column headings are also saved in them. 

To display a log file: 

1. Select File -> Open. 

2. the dialog for selecting a LOG file is opened with focus on the configured default folder 

3. Select the desired file. 

4. The LOG file is displayed 

 

5. Double click an entry to open the detail view. 
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RECOGNIZING QUEUE OVERFLOW AT DRIVER 

If messages of a driver are deleted because of queue overflow, the Diagnosis Client and the Diagnosis 

Server set a marker in the new entry when writing a new entry for all activated modules (on page 37) 

that older entries were deleted from the queue. The overflow recognitions contained in the opened 

log files are counted: 

 

Parameter Description 

Column Record version This column must be part of the column selection. It shows 

the version of the data record. Version 8x tags overflows. 

Counter 82 8 refers to overflow, 2 refers to the concerned version of 

the data record. 

Status line queue overflows If status bar is active, the number of overflows is displayed 

there. 

Note: Not all entries written in the log file are displayed. If a not displayed log data record is tagged 

with an overflow, it will be displayed at the next visualized data record of this client. If several not 

displayed entries in a row are tagged with an overflow, the counter in the status bar can deviate from 

the number of data records with overflow tags. 
 

3.6.1 Global settings 

The entries are in the English language. 

Parameters Description 

File Commands in menu File. 

Open Opens dialog for selecting a log file saved in TXT format. Each newly 

opened log file is displayed in its own window. 
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Parameters Description 

Open to active 

document 
Each new log file is added to the active window. 

Close Closes the active window. 

Save Saves the log files of the active window. 

Save as Saves the current view of the active window (e.g. filter settings) to a file 

to be selected. 

Remote Download Only available, if a connection to a Remote Diagnosis Server exists. 

Enables the download of logging files of the Remote Server to the local 

log folder. A subdirectory with the name of the PC is created. Only file, 

which have changed or which are new, are available. 

Connect to Opens the dialog for the Connection selection (on page 23). 

Online Activates the online error view.  

If online logging is started, all incoming entries are displayed. The same 

filter dialog as for reading files can also be set here.  

Difference: If no log connection is selected, all incoming log entries will 

be displayed, otherwise only the ones from the selected clients.  

If the filter of the log connection is modified, all entries not fulfilling the 

filter criteria will be lost. (Logging file nevertheless is created and all 

entries are saved.) Displayed entries can be saved. 

Offline Deactivates the online error view. (Default) 

Exit Closes the Diagnosis Viewer. 

 
 

3.6.1.1 Connection settings Diagnosis Server connection 

The Diagnosis Viewer automatically connects to a selected default Server at the start. If no default 

server is defined, localhost is used as default server. 

Recommendation: Set up the server configuration using the entries in zenon6.ini (on page 13). 
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SELECT DIAGNOSIS SERVER 

Click on File -> Connect to... to open the dialog to select a server: 

 

Parameter Description 

List Server Lists all configured Servers and displays them: 

 Status:  

Con: connected server 

Def: Default Server. This is shown on opening. 

 Name 

 Port 

 Timeout 

OK Applies settings and closes the dialog. 

Cancel Discards settings and closes the dialog. 

New Server Opens the dialog for configuring a new Server. 

Delete Server Selected Server entry is deleted from the list. 

Edit Server Opens the dialog for configuring the selected Server. 

Connect to Establishes a connection to the selected Server. 

As default Selected server becomes default server. 
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CREATE AND EDIT DIAGNOSIS SERVER 

Click on New Server or Edit Server in dialog Diagnosis Server connection to open the dialog for 

configuring the Server: 

 

Parameter Description 

Server name Name of the PC to which to connect.  

Each computer can only be entered as a server once. 

The following must run on the PC: 

 up to version 6.51: zenSysSrv 

 from version 7.00: zenLogSrv 

Port Port of the service on the target computer: 

 Up to version 6.51: 1101 

 From version 7.00: 50780 

Timeout Time in seconds to wait for a response from the Sysservice. 

Default: 10 s 

OK Applies settings and closes the dialog. 

Cancel Discards settings and closes the dialog. 
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3.6.1.2 Column settings  

You can select the columns that are to be displayed in the menu under Settings -> Column settings. 

The selection is only applicable for the time period in which the file is opened. Column settings can 

however be saved as profiles. 

 

Parameters Description 

available available columns 

selected Columns which are displayed 

> adds columns selected at "available" to "selected" 

>> adds all available columns at "available" to "selected" 

< removes selected columns from "selected"  

<< removes all available columns from "selected" 

^ sorts selected entries one level higher (multi-select is possible) 

v sorts selected entries one level lower (multi-select is possible) 

OK Applies settings and closes the dialog. 

Cancel Discards settings and closes the dialog. 

Columns can also be configured via the context menu: 

Parameters Description 

Add all columns with Adds all columns which contain entries. 
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Parameters Description 

entry 

Remove Column Hides the selected column. 

Remove all empty 

columns 
Hides all columns which do not contain entries. 

Column width automatic The width of the selected column is automatically adjusted to the 

longest entry 

All columns widths 

automatic 
The width of all columns is automatically adjusted to the longest 

entry 

 
 

3.6.1.3 Profiles 

Column settings can be saved as profiles. 

To save profiles: 

1. Enter a name into the filed in the toolbar. 

2. Click on the symbol with the disk. 

To load profiles: 

1. Select a saved profile from the drop-down list. 

2. Click on the symbol with the disk. 

The profiles are saved as a *.lvs file.  
 

3.7 Possibilities of Filtering 

To define filters open the corresponding filter dialog via the corresponding symbol or the tab of the 

filter. 

SYMBOL BAR FILTER 

To use the symbol bar, you must activate it in menu View via menu item Icon bar. 

 

Symb

ol 

Tool tip Description 

1 Change pre-filter settings Opens dialog with five tabs for defining filters. 
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Symb

ol 

Tool tip Description 

2 Change pre-filter for 

IP-ProcessID-LogID 
Opens tab IP address - Process No - Log ID (on page 36). 

3 Change pre-filter for 

modules 
Opens tab Modules (on page 37). 

4 Change pre-filter for 

additional columns 
Opens tab Additional columns (on page 38). 

5 Change pre-filter for time 

interval 
Opens tab Time interval (on page 39). 

6 Change pre-filter for 

coloring 
Opens tab Colors (on page 40). 

FILTER DIALOG 

 

Tabs Description 

IP-ProcessID-LogID Opens tab IP address - Process No - Log ID (on page 36) for 

configuring the connection which should be logged. 

Modules Opens tab Modules (on page 37) for the modules which should 

be logged. 

Additional columns Opens tab Additional columns (on page 38) for selecting 

additional columns which should be displayed. 

Time interval Opens tab Time interval (on page 39) for defining time filter. 
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Tabs Description 

Colors Opens tab Colors (on page 40) for selecting the color-coding of 

information. 

 
 

3.7.1 IP address - Process No - Log ID 

Configuration of the connections and processes which should be displayed. 

 

Parameter Description 

available List of available connections. 

selected List of selected connections. 

[Arrow keys] Add selected (>) or all (>>) connections to list selected or removes 

them from the list (< or <<). 

OK Applies all changes on all tabs and closes the dialog. 

Abbrechen Discards all changes on all tabs and closes the dialog. 
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3.7.2 Modules 

Selection of the modules which should be displayed. 

 

Parameters Description 

Module filter active Active: It is filtered on modules.  

With this only LOG data records are displayed which are 

assigned to a selected module. 

available Available modules. 

selected Selected modules. 

Cursor keys Add selected (>) or all (>>) connections to list selected or 

removes them from the list (< or <<). 

OK Applies all changes on all tabs and closes the dialog. 

Cancel Discards all changes on all tabs and closes the dialog. 
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3.7.3 Additional columns 

Selection of the columns which should be displayed additionally. 

 

Parameters Description 

available List of the available columns. All field definitions existing in the file are 

displayed.  

selected List of the selected columns. 

Cursor keys Add selected (>) or all (>>) connections to list selected or removes 

them from the list (< or <<). 

OK Applies all changes on all tabs and closes the dialog. 

Cancel Discards all changes on all tabs and closes the dialog. 
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3.7.4 Time interval 

Configuration of the time filter for displaying the entries. 

 

Parameter Description 

Start time: Selection of the date and point in time from which entries should 

be displayed. 

Default: Current date 

End time: Selection of the date and point in time up to which entries should 

be displayed. 

Default: Current date 

Reset time interval Sets filter back to default. 

OK Applies all changes on all tabs and closes the dialog. 

Cancel Discards all changes on all tabs and closes the dialog. 
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3.7.5 Colors 

Selection of the color display of the information. 

 

Parameters Description 

Colors for: Selection of the color 

IP address Active: Different IP addresses are colored differently.  

Modules Active: Different modules are colored differently. 

Log connection Active: Different names of the log connection are colored differently.  

no colors Active: Entries are not colored. 

OK Applies all changes on all tabs and closes the dialog. 

Cancel Discards all changes on all tabs and closes the dialog. 

 
 

3.8 Reading the log files 

One or more log files can be opened in an analysis at the same time. A pre-filter (on page 34) has to 

be set to limit the display. This is possible with five property pages. This filter can be modifies later on. 

If the filter is set, only the entries fulfilling these filter criteria are displayed. The entries are listed 

chronologically. 
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FILTER COLUMNS 

Another filter possibility is available with the filter columns. Filter criteria can be entered for each 

column in the input field below the column header. The fields support Regular Expressions, so that 

also complex filter criteria can be defined. The list can be sorted ascending or descending by clicking 

the column headers. Displayed entries can be saved. Fields to be displayed can be selected using the 

Settings -> Column settings menu entry. 

DEFAULT FIELDS IN THE LOG FILE: 

ID Parameter Description 

i IP address IP address. 

These fields identify the clients and allow the 

message to be assigned. 

i Log ID entry ID 

These fields identify the clients and allow the 

message to be assigned. 

i Message Level Name of the message level for which the message 

was entered. 

i Module Name of the module, which entered the message. 

i Process ID ID of the project. 

These fields identify the clients and allow the 

message to be assigned. 

i Record type Type of entry. 

i Record version Version number of the entry. 

i Thread ID ID of the thread, from which the message was 

entered. 

i Timestamp Time of the message in UTC. 

OPTIONAL FIELDS WITH FIX ID. 

ID Constant Description 

1 Name of log connection  Name of logging connection 

2 Thread name Name of the threads. 

3 Name of source files Name of the source file. 
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ID Constant Description 

4 Source line Source line 

5 Assert condition Assert condition 

6 Computer name Computer name 

7 Function name Function name 

8 Project name Project name 

9 Project GUID  GUID of the project. 

10 Project path Project path 

11 Sent Data Sent data 

12 Received data Received data 

13 no. serial interface Number of the serial interface. 

14 Baudrate Baud rate 

15 dtr setting DTR setting. 

16 rts setting RTS setting. 

17 Serial char. length Serial character length 

18 Parity Parity 

19 No. stopbits  Number of stop bits 

20 CTS CTS. 

21 dsr DSR. 

22 dsr sensitivity DSR sensitivity. 

23 Network port no. Port number in the network. 

24 Server name Server name. 

25 Standby name Name of standby server 

26 Client name  Client name. 

27 Server IP  IP address server. 

28 Standby IP IP address standby. 

29 Client IP IP address client. 
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ID Constant Description 

30 Binary buffer Binary buffer. 

31 Pointer Pointer 

32 Class name Class name 

33 Error code Error code: 

34 DLL instance handle DLL instance handle 

35 DLL name DLL name 

36 Driver error parameter 1 Driver error parameter 1 

37 Driver error parameter 2 Driver error parameter 2 

38 Trace Message Trace message 

39 Errortext Error text 

40 Error file name Name of error file. 

41 Success condition Condition for success 

42 Value if successful Value when successful 

43 Net adress Net address: 

44 Datablock Data block. 

45 Offset Offset: 

46 Bit number Bit number 

47 Area in PLC Area in the PLC. 

48 Communication direction Shows the direction of the communication in a 

string. 

49 General text General text 

50 Main version no. Number of main version. 

51 Sub version no. Number of sub-version. 

52 Build no. Build number. 

53 Servicepack Service Pack. 

54 Hotfix no. Hotfix number 
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ID Constant Description 

55 Sending client Client, which sent the command 

56 Target client for command Client that is the target of the command. 

57 Database no. Number of database. 

58 Datapoint no. Datapoint number (channel number) 

59 Datapoint value  Value of datapoint 

60 Datapoint status Status of datapoint 

61 Datapoint timestamp Time stamp of datapoint in seconds 

62 Duration in ms Error wait time in milliseconds. 

63 Number, counter number, counter. 

 
 

3.9 Structure of the LOG file 

Log files are ANSI text files. The individual fields are separated using tab characters. CR+LF is used as 

an end character. This data can be opened in Notepad as a result. 

Log file get the information sequentially, not sorted chronologically. 
 

3.9.1 Message levels 

Eight groups can be selected to divide the log messages. These are bit coded and can thus also be 

combined. 

1 Error message 

2 Warnings 

4 Success messages 

8 TRACE 

16 ASSERT 

32 LOG messages 

64 Debug 

128 Extended Debug 



Diagnosis Viewer 

 

45 | 142 

 

 

 
 

3.9.2 Search function 

With View/Find the current window can be searched. All hits are marked. 
 

3.10 Handling of errors and messages for the Diagnosis Viewer 

ERROR 

Error Possible causes 

The port cannot be opened.  Another application uses the port.  

Check via "netstat". 

 The ports for entries  

[SYS_REMOTE] CONFIG and  

[LOGGING_SYSTEM] CONFIG 

 are identical. zenLogSrv and zenSysSrv then try to 

open the same port. 

Diagnosis Clients do not start the 

zenLogSrv 

 zenAdminSrv was ended. Without it the service 

cannot be started. 

 zenLogSrv is not registered as a service at the PC. In 

this case enter the following in the command line: 

zenLogSrv.exe –Service 

 Diagnosis Clients are not of version 7.00 SP0 or 

higher. The zenLogSrv is only supported from this 

version on. 

 Under Windows CE: The individual components 

(Runtime, SysSrvCE, LogSrvCE) are located in different 

folders. They must be located in the same folder. 

Otherwise the components do not find one another. 

Under CE many processes are 

created by SysSrvCE.exe or 

LogSrvCE.exe. 

 One of the two entries in zenon6.ini  

[SYS_REMOTE] INIT or  

[LOGGING_SYSTEM] INIT  

has the value 2. 

As a result the application only displays the user 

interface and does not open the Listening port. Each 

Diagnosis Client then tries to start the process as it 

cannot connect to the Diagnosis Server. 

Several processes crash.  The versions do not match. Diagnosis Clients, 

Diagnosis Server and Diagnosis Viewer must either all 
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Error Possible causes 

(Unhandled Exceptions of the 

Diagnosis Server at receiving log 

messages or configuration 

commands or of the Diagnosis 

Client and Diagnosis Viewer during 

booting or during receiving the 

configuration) 

have version 7.00 SP0 or higher or all version 6.51 

SP0 or earlier (see Compatibility (on page 9)). 

LOG ENTRIES 

Entry Description 

SysSrv received not supported 

network message! 

zenSysSrv received a network telegram which is not 

supported. Example: Log entries. 

LogSrv received not supported 

network message! 

zenLogSrv received a network telegram which is not 

supported. Example: Remote Transport commands 

Could not open listening port. 

Server will be stopped. 

The zenLogSrv or the zenSysSrv could not open its 

Listening port. The error message is logged as follows: 

 zenLogSrv and zenSysSrv on the PC:  

Entry in the Windows event display. 

 zenSysSrv under CE:  

Message box for the user and log entry to the 

Diagnosis Server. 

 zenLogSrv under CE:  

Message box for the user. 

The following log entries are assigned to different systems. The first part of the messages states 

whether service or Client are effected: 

 SysSrv: zenSysSrv 

 SysCli: Client for zenSysSrv 

 LogSrv: zenLogSrv  

 LogCli: Diagnosis Client 

Entry Description 

[SysSrv/LogSrv/SysCli/LogCli] Info 

InitString [String] 

A network connection has been initialized with the 

displayed configuration string. Server opens ports and 

Clients connect to the Server. 

[SysSrv/LogSrv/SysCli/LogCli] An exception occurred during a network operation. The 
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Entry Description 

WINSOCK ERROR details are also displayed. 

[SysSrv/LogSrv] Accept Failed! An incoming connection from a Client could not be 

accepted. 

[SysSrv/LogSrv/SysCli/ LogCli] 

Write Faild 

Not all data which should be sent could be sent. The 

number of the sent bytes and the number of the bytes 

which should be sent is displayed. 

[SysSrv/LogSrv] Client [String] in 

List Delete! 

The Client log off from the Server. 

[SysSrv/LogSrv] Client [String] in 

List Insert 

The Client log on to the Server. 

 
 

4 Online updating of the zenon Help: 

The Documentation Download Tool manages the updating of your online help including embedded 

help, dialog help, tooltips and the PDF product documentation from zenon and zenon Logic. 

The updating is carried out online. An internet connection is necessary for this. 

CONTENTS OF THE DOCUMENTATION UPDATE: 

The Documentation Download Tool supports the updates of: 

 zenon and zenon Logic product documentation 

 Driver Documentation 

 Tutorials 

 Glossary 

FILE FORMATS OF THE DOCUMENTATION UPDATE: 

The Documentation Download Tool supports the updates of: 

 Online help for zenon and zenon Logic (.chm) 

 zenon product documentation (.pdf) 

Note: The tool is only available in English 
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4.1 Installation 

The Documentation Download Tool is automatically installed with zenon. 

 
 

4.2 Starting the program 

To start the Documentation Download-Tool: 

1. Go to the following folder: %PROGRAMFILES(X86)%\Common Files\COPA-DATA\STARTUP. 

2. Start the program called DokumentationDownloadTool.exe by double-clicking on it. 

The program start dialog opens 

 
 

4.3 Navigation 

It is possible to navigate through the individual dialogs by means of the navigation bar in the lower 

area of the dialog: 

 

Button Description 

Exit Closes the Documentation Download Tool 

Back Goes back one dialog in the tool process. 

Next Goes forward one dialog in the tool process. 
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Button Description 

Proxy Settings Opens/closes expandable list for the configuration 

of the proxy settings (on page 49). 

Only active in the start dialog. 

 
 

4.4 Proxy Settings 

The proxy settings of your network can only be configured using the Proxy Settings entry. 

To call this up, click on Proxy Settings in the start window of the tool. It is only possible to call this up 

in the start dialog. This property is not active in subsequent dialogs. 

 

Parameter Description 

Auto-detect proxy settings for this 

network 

The proxy settings of your system are used for 

communication with the internet. 

(Default: active) 

Manual proxy configuration Enables the proxy settings to be configured. 

Proxy: Address of the proxy server 

Port: Proxy server port 

(Default: 8080) 

User: User name on the proxy server (optional) 

Password: Password on the proxy server (optional) 

 

  Information 

The Documentation Download Tool notes these proxy settings. If you regularly 

change your password, you must also change the password in the proxy settings 

of the Documentation Download Tool. 
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4.4.1 Incorrect proxy settings 

 

An error dialog appears with incorrect entries. 

Confirm this error dialog with OK to automatically return to input of the Proxy Settings. 
 

4.5 Selection of version 

In this dialog, select the version of zenon to be updated. 

 

Parameter Description 

List of installed versions Lists the versions of zenon installed on the 

computer. 

Select the version to be updated by simply clicking. 

Note: only one version of COPA-DATA can be 

updated each time. Multiple selection is not 

possible. 

Exit Closes the Documentation Download Tool 
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Parameter Description 

Next Goes forward one dialog in the tool process. 

Proxy Settings Not active in this dialog. 

 
 

4.6 Language dialog 

In this dialog, you select the zenon language to be updated. 

 

Parameter Description 

List of available languages Lists the languages available for zenon: 

 English (ENGLISH) 

 French (FRENCH) 

 German (GERMAN) 

 Italian (ITALIAN) 

 Russian (RUSSIAN) 

 Spanish (SPANISH) 

Select the language to be updated by clicking on 

it. 

Note: only one version of COPA-DATA can be 

updated each time. Multiple selection is not 
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Parameter Description 

possible. 

Exit Goes back one dialog in the tool process. 

Back Goes back one dialog in the tool process. 

Next Goes forward one dialog in the tool process. 

Proxy Settings Not active in this dialog. 

 
 

4.6.1 No updates available 

If online and offline help is up to date, a dialog appears: 

 

Clicking on the OK button reverts to the Language dialog. 
 

4.6.2 Language-dependent content of zenon help 

Available language content for zenon and  zenon Logic: 

Language Embedded help Online/offline help Online/offline driver 

documentation 

English English English English 

French French English English 

German German German German 

Italian Italian Italian English 

Russian Russian English English 

Spanish Spanish English English 
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4.7 Overview of available updates 

Once the update conditions have been selected, a dialog with the available updates is displayed: 

 

Parameters Description 

List of available Updates. List of the documents that are available for the 

selected version of zenon. 

Note: the list is for information only. Selection is 

not possible. 

Exit Closes the Documentation Download Tool 

Back Goes back one dialog in the tool process. 

Next Goes forward one dialog in the tool process. 

Proxy Settings Not active in this dialog. 
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4.8 Status dialog 

This dialog shows the progress when downloading the PDF or online help file to be updated. 

 

Parameters Description 

Fileinformation Detailed information on the file that is currently 

being downloaded: 

 File origin 

 File size 

 Save location on the local computer 

Current File: Status of the current file including current 

download speed 

Overall Progress Status of the complete update including 

percentage and remainder display 

Exit  Cancels the download that is currently in 

progress 

 Closes the Documentation Download Tool 

Pause Pauses the current download 

Resume Resumes the download that was paused (by 

clicking on Pause).  

This button is only active if the Pause button has 

been pressed beforehand 
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Parameters Description 

Cancel Cancels the current download 

Proxy Setting Not active in this dialog. 

 
 

4.8.1 Download complete 

The following dialog is shown once the download has been completed: 

 

Parameter Description 

Exit Closes the Documentation Download Tool 

Resume Not active in this dialog. 

Restart Reverts to the start dialog (on page 48) of the tool. 

Proxy Settings Not active in this dialog. 
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4.8.2 Cancel 

The following dialog is displayed once the Cancel button has been clicked: 

 

Parameters Description 

Exit Closes the Documentation Download Tool 

Resume Not active in this dialog. 

Restart Reverts to the start dialog (on page 48) of the tool 

Proxy Settings Not active in this dialog. 

 
 

5 Keyblock Runtime Start 

Keyblock Runtime Start is a program with which zenon Runtime runs as a Shell. In doing so, zenon 

Runtime is started, but all Windows system tasks are blocked. Keyboard shortcuts such as the 

Windows key + L or Ctrl+Alt+Del no longer have an effect. 

Note: Ctrl+F4 cannot be blocked. To lock all key combinations with the Windows key: Deactivate the 

Windows key in the Startup Tool (on page 72) under Application -> Options -> General. 

You can find details in the Use (on page 57) chapter. User can no longer access the operating system 

but only work on the zenon user interface. Limitations from the Lock system keys project property 

are thus enhanced. 
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The precondition for this is that the project properties are set Runtime title to No title (full screen). 

Then zenon runs in full screen mode and the Runtime cannot be minimized. 

This locking cannot be bypassed during Runtime. When the Runtime is closed normally, the system 

restrictions are canceled. If the Runtime is to be operable without these limitations, Runtime must be 

started without the Keyblock Runtime Start. 

Note also the information provided in the Protect Runtime files (on page 58) chapter. 
 

5.1 Use 

To use Keyblock Runtime Start: 

1. In the Windows start folder, under COPA-DATA, open the zenon Tools. 

2. Select Keyblock Runtime Start. 

3. The program is opened and automatically starts Runtime. 

4. The program blocks all access to the operating system. 

BLOCKED FUNCTIONS 

Locked keyboard shortcuts: 

 Ctrl+Alt+Del  

 Ctrl+Esc 

 Alt+Tab  

 Alt+Esc 

 Alt+F4 

 Windows+L and the functionality of the Windows key itself 

To block all key combinations with the Windows key: Deactivate the Windows key in the 

Startup Tool (on page 72) under Application -> Options -> General.  

Note: Ctrl+F4 cannot be blocked. Windows keys 

System locks: 

 Hiding of the control panel in the start menu. 

 Locking of the toolbar for operation. 

 Prevents: 

 Changing passwords 

 Closing Windows 

 Logout 
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 Locking the computer 

 User change 

 Hiding of all elements in the task manager. 

Notes: 

 When locking the system keys, normal operation of the scroll bars with the mouse in the 

Runtime is also blocked. You can work around the blocking with the help of the context 

menu. 

 To block all Windows keys: Deactivate the Windows key in the Startup Tool (on page 72) 

under Application -> Options -> General. 

Attention 

Take care that you engineer a possibility to close the Runtime in your project. 

There is no possibility to end the Runtime regularly. 

 It can only be ended by shutting the computer down using the hardware 

 All system keys also remain blocked after restarting 

In order to make system keys accessible again after not being shut down 

properly (in the event of a power cut for example): 

 start the Runtime again with the help of Keyblock Runtime Start 

 end the Runtime regularly via a close button 

NOTES ON AUTOSTART 

If Keyblock Runtime Start is started using the operating system's startup process, then note the 

following: 

 The Autostart folder is user specific:  

If another user logs in, the program is not executed. 

 Execution of the Autostart programs can be prevented by pressing the Shift key when the 

operating system is booting. 
 

5.2 Protect Runtime files 

The access to the Runtime files can be strongly restricted and therefore well protected. At this only a 

single Windows user has read and write rights for the Runtime folder. All other Windows user do not 

have any rights in the Runtime folder including read rights. Operators in the Runtime log on as zenon 

users. 

In order to limit access to the file system: 
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1. Only create a single Windows user (for instance: zenon_ADMIN) who is authorized to start 

zenon as well as to read and write in the zenon Runtime folder. 

2. Disable access to the zenon Runtime folder for all other Windows users – including read 

authorizations! 

3. Disable any remote access to the user zenon_ADMIN. 

4. Block any software for remote maintenance or remote access. 

5. Make sure that zenon can only be started if this user (zenon_ADMIN) is logged in. 

Since other Windows users do not have read authorization Runtime will only start in the 

context of this user (zenon_ADMIN). 

6. Make sure that zenon runs as shell: 

a) For this purpose, create a zenon autostart with Keyblock Runtime Start (on page 57) 

b) Activate the property Lock system keys in the group Runtime settings of project 

properties. 

c) Start zenon in full-screen mode: Set property Runtime title to No title. 

d) Ensure that you also take multi-monitor systems into account during configuration. 

e) Disable Explorer start 

f) Do not offer file selection dialogs. 

Note: In this case, no functions that require the user to select files in the Runtime can be 

configured. 

Access to the zenon file system is thus restricted. 

 
 

6 Service Node Configuration Tool 

You use the Service Node Configuration Tool (SNCT) to establish a connection to the Service Hub. The 

Service Node to be configured gets the required credentials in the form of a Certificate Bundle from it. 

To issue a Certificate Bundle, the computer on which the Service Node Configuration Tool is running 

must trust the HTTPS certificate of the Hub Controller. If this is not the case, an error message is 

displayed when establishing a connection. It is possible to have the information of the certificate 

displayed and then decide whether a connection should be established or not.  
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Attention 

The connection can only be established if the trustworthiness of the certificate 

has been ensured by inspecting it.  

If the certificate and thus the desired connection cannot be identified as being 

trustworthy, the connection cannot be established.  Otherwise, there is the risk 

of Man-In-The-Middle attacks and thus a weak point for an attack on the 

system. 

CERTIFICATE 

The SNCT requires a certificate for the secure connection to the Hub Controller. If this is not available, 

an error message is displayed when establishing a connection. The error message can be accepted 

and the connection can still be established. 

Recommendation: Install a trustworthy certificate as early as possible. 

INSTALL CERTIFICATE FROM THE HUB CONTROLLER 

In order to install the certificate: 

1. Log in to the Hub Controller. 

2. Download the CA certificate by clicking on Download certificate in the Certificate tab. 

3. Install the certificate in the Windows Certificate Store Trusted Root Certification Authorities. 

4. Start Service Node Configuration Tool. 

START SERVICE NODE CONFIGURATION TOOL 

To start the Service Node Configuration Tool:  

1. Open Windows Start. 

2. Search for SNCT. 

3. Open the provided desktop app.  

Alternative: 

1. Open the zenon Startup Tool. 

2. Click on the Tools button. 

The Start external application dialog is opened. 

3. In the Available applications (current folder) section, select the Service Node Configuration 

Tool entry. 
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4. Click on Start. 

The Service Node Configuration Tool is opened. 

Note: The Services Nodes that are available for configuration also depend on the product that is 

activated in the Startup Tool. For example, if the zenon web client is active, the products zenon Editor 

and zenon Runtime are not offered. 

OPERATE SERVICE NODE CONFIGURATION TOOL 

You use the Service Node Configuration Tool to configure the connections of the Service Nodes via 

the tabs: 

 Selection: Selection of the Service Nodes that are to be connected to the Service Hub. 

 Connection: Entry of the connection parameters to the Service Hub. 

 Retrieval: Check of the connection and configuration of the Service Nodes. 

These can only be edited in order. In order to be possible to switch to the next step, the current tab 

must be configured correctly. Errors are highlighted with a red frame the next time there is an 

attempt to switch further. 

To configure the connection from a Service Node to the Service Hub: 

1. In the Selection tab, select the Service Nodes that are to be configured.  

 

2. Click on Next. 
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The Connection tab is opened. 

3. Enter the address under which the hub controller can be contacted. 

4. If the default port is not used: 

a) Activate the Custom option. 

b) Enter the port to be used. 

5. Enter a user name and password. 

6. Optional: Enter an alias. 

 This makes it easier for the user to find information during operation. 

7. Click on Execute. 

The connection data entered is validated. 

The Retrieval tab is opened. 

A connection to the Hub Controller is established and the credentials for the 

previously-selected Service Nodes are queried from the Hub Controller. These Service Nodes 

are then configured with their respective credentials. 

The individual steps are displayed in the form of log messages. These inform you of 

successful execution, as well as problems with the establishment of a connection to the Hub 

Controller, the data query or the configuration of the Service Nodes. 

 

8. Close the dialog by clicking on Close. 
 

6.1 Dialog: Service Node Configuration Tool 

The user interface of the Service Node Configuration Tool is divided into three tabs: 
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 Selection 

 Connection 

 Retrieval 

SELECTION 

Here you can configure the Service Nodes that are to be connected to the Service Hub. 

 

Column Description 

Connect Selection of the Service Nodes that are to be connected to the 

Service Hub . 

Click the checkbox to select the respective Service Node for 

the following steps. 

Service Node Display of the installed Service Nodes that can be connected 

to the Service Hub. 

Note: The following is applicable for zenon Runtime or 

zenon Editor: 

 zenon Runtime: Two Certificate Bundles are created, 

one for the Runtime and one for the Runtime Add-In. 

 If a Runtime or the Editor are selected, Certificate 
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Column Description 

Bundles are also created for the Predicitve Analytics 

driver and the SERVICEGRID driver. 

Latest version Display the current version number of the Service Node. 

Configured Service Hubs Display the previously configured connections for the Service 

Node. 

NAVIGATION 

Option Description 

Close Closes the dialog. Changes that have not been saved are lost. 

Back Goes back one tab. 

Not available for Selection. 

Next Moves one step forward to Connection.  

Only available if at least one Service Node has been selected. 
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CONNECTION 

Here you can configure the connection to the Hub Controller. 

 

Option Description 

Host name or address Address at which the Hub Controller can be contacted. Input 

as IP address or host name. 

at least have to have 1 character 

Port Selection of the port at which the Hub Controller can be 

contacted: 

 Default: The port selected by the system is used. 

Default: 9410 

 Custom: The port selected by the user is used.  

Entry of the port number in the field. 

Permitted values: 1 to 65535. 

Note: Make sure that the user-defined port is not 

blocked by the firewall. 

Username Entry of the user name for the Hub Controller. 

Must contain at least 1 character. 

Password Entry of the password for the Hub Controller. 

Must contain at least 1 character. 
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Option Description 

Alias Optional entry of an alias for the Service Node. 

This is used, for instance, by the zenon Editor or zenon 

Analyzer to make it easier for the user to distinguish between 

the configured connections later on. 

NAVIGATION 

Option Description 

Close Closes the dialog. Changes that have not been saved are lost. 

Back Goes back one tab. 

Execute Checks the entered connection parameters and starts the 

configuration of the previously selected Service Nodes. 

RETRIEVAL 

The credentials for the selected Service Nodes are requested and configured here. 

All the steps performed are listed. 

The successful configuration of the Service Nodes and any problems that occur are also displayed. 

The messages in the window can be highlighted and copied. 
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Column Description 

Level Uses a symbol to show the type of message that is displayed. 

Message Information on the individual steps performed. 

All information can be copied from the window. 

NAVIGATION 

Option Description 

Back Goes back one tab. 

Not available for Selection. 

Close Closes the dialog. 

 
 

7 Startup Tool 

The Startup Tool enables you: 

 to start Editor and Runtime with certain parameters 

 to run different zenon versions on one computer in parallel  

(already installed zenon versions are automatically created in the Startup Tool) 

 to administrate different SQL instances for the same zenon version 

 to administrate the settings for different versions 

 to define the language of the Editor and the Runtime before the start 

 To define the language of the web client 

 to start tools in the Startup Tool directly 

Attention 

The Startup Tool only starts if the zenAdminSrv service is running. If it is not 

active, you can start it manually in the Windows Control Panel under 

Administrative Tools/Services. 
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7.1 Start dialog 

You administrate the currently installed zenon versions in the start dialog. From version 7.10, you have 

the possibility to choose whether to start the Editor and the Runtime as a 32-bit application or as a 

64-bit application. 

If only a 32-bit version of zenon 7.10 was specified or an older version was detected, only one button 

is shown for the Editor and Runtime respectively: 
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If both versions are specified, separate buttons for 32-bit and for 64-bit are displayed. 

 

Button Function 

List of zenon versions. Shows all installed zenon versions. 

Move entry down Moves the selected entry in the list downwards. 

Move entry up Moves the selected entry in the list upwards. 

Editor Starts the Editor of the selected zenon version 

Two buttons each are displayed when the 64-bit 

version is installed: 

 Button to start the 64-bit version. 

 Button to start the 32-bit version. 

The appearance of the 32-bit version is 

also marked with a small graphic 
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Button Function 

indicator in the button. 

In addition, a tooltip is visualized if the mouse is 

moved over a button. 

Runtime Starts the Runtime of the selected zenon version 

Two buttons each are displayed when the 64-bit 

version is installed: 

 Button to start the 64-bit version. 

 Button to start the 32-bit version. 

The appearance of the 32-bit version is 

also marked with a small graphic 

indicator in the button. 

In addition, a tooltip is visualized if the mouse is 

moved over a button. 

Register Registers all services of the selected zenon version 

for Editor, Runtime and HTML web engine: 

 Standard: Registers zenon. ZenSysSrv is 

registered as a process. 

 Terminal Server: Registers zenon for use 

with a terminal server. Procedures:  

ZenDBSrv is deregistered and no longer 

re-registered and also not started.  

ZenSysSrv is registered as a service.  

The entries in zenon6.ini are amended for 

use on the terminal server. 

If, in an entry, there are no parameters (on page 

92) stored for workspace or Runtime, the current 

version is re-registered. This applies for 

registration as a standard server and as a terminal 

server. 

Help Opens online help. 

Update Help Starts the Documentation Download Tool (on 

page 47). 

Tools Opens a dialog (on page 101) for starting 

additional applications of the selected zenon 

version 
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Button Function 

If the tools for a valid 64-bit version are opened, 

then the tools are displayed in two lists for 32-bit 

tools and 64-bit tools. 

Hint: Actions for the selected element are also available as a context menu for the symbol in the 

system tray. 

PROCESSES DURING STARTING 

When starting the Editor or the Runtime, data from the start settings are written to the zenon6.ini file. 

Existing settings in the INI file are overwritten. 

From version 5, network communication has been handled with the two services zenNetSrv.exe and 

zenSysSrv.exe. Both files must exist in the zenon folder. As these services are version dependent, they 

must be registered for the appropriate version. 

Attention 

After conversion of a project into a later zenon version, this can no longer be 

edited with the previous version or will no longer run on it. However, the backup 

version created during the conversion can still be used in the original editor. 

For network projects, the same zenon Editor versions must be started on the 

server and clients. 

 
 

7.1.1 Application 

Entry Function 

Options Opens the dialog for configuring the 

settings. 

Exit Closes the Startup Tool. 

OPTIONS 

 The Options entry in the Application menu opens the dialog to configure the properties for: 

 General (on page 72): 

General settings 

 Network configuration (on page 76): 

Configuration of the network and the strong encryption of network communication 



Startup Tool 

 

72 | 142 

 

 

 Listening ports (on page 82): 

Configuration of the monitoring ports 

 Service startup (on page 86): 

Start programs as a service 
 

7.1.1.1 General 

General settings: 
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Note: This dialog is only available in English.  

The buttons are displayed in the system language of the computer. 

Option Active 

Start Startup Tool 

mimimized 

Start behavior of the startup tool: 

 Active: Starts the Startup Tool minimized. You can reach the tool 

with the help of its icon in the task bar.  

The context menu offers all possible actions from the start 

dialog (on page 68) for the active zenon. 

 Inactive: Opens the tool on the desktop (default). 

Default: inactive 

Remember last 

registered version 

Selection of the last-registered version: 

 Active: Sets the chosen version as standard and selects it 

automatically at the next start. Then the version is not registered 

again (default). 

 Inactive: Offers the first version in the list when starting the 

Startup Tool. When the Editor or the Runtime are started, the 

respective version is always registered again. 

Default: active 

Language for Editor 

and Runtime 

Starts Editor or Runtime in the selected language.  

Select from drop-down list: 

 Czech 

 Chinese 

 German 

 English 

 Spanish 

 French 

 Italian 

 Russian 

 Korean 

 Japanese 

Ensure that zenon is started with the language defined in the Startup 

Tool. Has no influence if zenon.exe is started directly. 

Disable Windows Windows button action: 
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Option Active 

Key 
 Active: The Windows- key is blocked on the keyboard and is not 

functional.  

Changes only take effect after the system has been restarted. 

This required restart is visualized with a dialog. 

 Inactive: The Windows- key is available.  

Changes only take effect once the system has been restarted. 

This required restart is displayed with a dialog. 

Default: inactive 

For details, see the Action of the option Disable Windows Key. 

REMOTE LICENSE SERVICE 

Settings for the use of the remote licensing service and license loan. 

Option Active 

Enable remote 

licensing 
Allows the licensing of a computer via another computer in the 

network. 

 Active: Remote licensing is possible. 

 Inactive: Licensing is only possible on the computer directly. 

Default: inactive 

Enable license 

borrowing 

Allows the loaning of licenses to another computer. 

 Active: Licenses can be loaned out. 

 Inactive: No licenses can be loaned out. 

Default: inactive 

VSTA 

Settings for the use of VSTA. 
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Option Active 

Enable VSTA Enables the use of VSTA. 

Only available if VSTA has already been installed or an installation 

package has been found on the system. 

 Active: VSTA can be used.  

If VSTA is not installed, but an installation package is available, 

the installation will be offered. 

The installation starts as soon as this dialog is closed by clicking 

on OK.  

Attention: The .Net Framework 3.5 must have already been 

installed. 

The checkbox can only be activated on a lasting basis if VSTA is 

installed correctly. 

 Inactive: VSTA is deactivated and not available in zenon Editor. 

Default: inactive 

BEHAVIOR OF THE DISABLE WINDOWS KEY OPTION 

The Disable Windows Key option behaves as follows: 

Set block 

 Initial situation: The option is not set. 

 Action: The option is activated. 

 Result: 

 The system must be restarted. 

 The Windows- key is deactivated for operation. Windows- keyboard shortcuts are 

blocked. 

Undo block 

 Initial situation: The option is not set. 

 Action: The option is deactivated. 

 Result: 

 The system must be restarted. 

 The Windows- key is available for operation. The block of the Windows- key 

combinations is released. 
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7.1.1.2 Network configuration 

The following applies for zenon from version 7 onwards: 

 you can use IPv6 

 you can encrypt the transfer in the network. 

This dialog configures: 

 Timeouts 

 the use of TCP/IP via IPv4 or IPv6 

 the serious encryption of the network communication at the local computer 
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 the encryption for Runtime connector 

 

Note: This dialog is only available in English.  

The buttons are displayed in the system language of the computer. 

GENERAL SETTINGS 

General settings. 

Changes of these settings are written to the registry in the zenon6.ini file and overwrite manual 

configurations that may be different. 
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Changed settings must be carried out for all Runtime computers or all connected stations. At changes 

of the IPv6 settings, the computer must be restarted. 

Changes are carried out after leaving the dialog only after the confirmation of a warning message by 

clicking on the Yes button. 

Parameter Description 

Network communication timeout Timeout for network communication in seconds.  

Default: 30 

Corresponds to the NET_TIMEOUT_MSEC= entry in 

zenon6.ini. 

Network module timeout Timeout for module communication in seconds. Is not 

used for spontaneous module request on the client or 

standby. If no response comes from the server in the 

set time, the action is canceled. 

Default: 30 

Examples: Call up of archive data for Extended Trend, 

recipe administration, password list ... 

Corresponds to the 

NET_NETMODULTIMEOUT_MSEC= entry in 

zenon6.ini. 

Time synchronisation with server 

project 

Checkbox for the setting of the time synchronization. 

 Active:  

Time is synced with a server project (default). 

 Inactive:  

Time is not synced (for circular redundancy, 

for example) 

Default: inactive 

Corresponds to the TIMESYNCH= entry in zenon6.ini. 

Use IPv6 for all TCP/IP connections Checkbox for the activation of IPv6 for TCP/IP 

communication. 

 Active:  

All TCP connections are only established via 

IPv6. 

 Inactive:  

All TCP connections are only established via 

IPv4. 
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Parameter Description 

Default: inactive 

Dual operation is not possible. 

Corresponds to the USEIPV6= entry in zenon6.ini. 

Note: If this option is changed, the computer must be 

rebooted. The change must also be carried out on all 

connected stations. 

The following components are not affected by the 

setting (IPv4 used): 

 Driver communication with the PLCs 

 Protocol communication in the Process Gateway 

plug-ins 

 Workbench and Runtime communication in 

zenon Logic 

 SNMP trap service communication 

(zenSnmpTrapSrv.exe) with the SNMPNG32 

driver 

Attention: Only works with version 7 onwards. No 

versions prior to version 7 can be started if this is 

active. 

ENCRYPT NETWORK COMMUNICATION 

Settings for serious encryption in the network 

Parameter Description 

Encrypt network communication Checkbox for the activation of strong encryption. 

 Active:  

Communication is encrypted. 

 Inactive: 

Communication is not encrypted. 

Default: inactive 

Password Input field for the password for encrypted network 

communication. 

For the criteria, see the "Network encryption password" 

section in the Strong encryption of network 
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Parameter Description 

communication chapter. 

The displayed length is always set at 20 characters, in 

order to hide the actual length. 

The password defined here is stored encrypted in the 

zenon6.ini. 

Confirm password Input field for password confirmation. 

enter password for confirmation again. 

ENCRYPT RUNTIME CONNECTOR COMMUNICATION 

Settings for encrypted communication of the HTML web engine, the SCADA Runtime connectors 

(zenon and <ZRS> and the Remote Runtime driver (RemoteRT.exe). 

Parameter Description 

Encrypt Runtime Connector 

communication 

Checkbox for the activation of encrypted 

communication with SCADA Runtime connectors 

(HTML web engine, zenon, zenon Analyzer) and 

Remote Runtime driver. 

 Active:  

Communication in the network is 

encrypted. 

 Inactive: 

Communication in the network is 

encrypted. 

Default: inactive 

Note: This encryption is also applicable for zenon 

web client communication. 

Password Input field for the password for encrypted network 

communication. 

For the criteria, see the "Network encryption 

password" section in the Strong encryption of 

network communication chapter. 

The displayed length is always set at 20 characters, 

in order to hide the actual length. 

Corresponds to the ENCRYPTION_PWD= entry in 

zenon6.ini. 
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Parameter Description 

Confirm password Input field for password confirmation. 

enter password for confirmation again. 

 

Attention 

If entries were changed manually in the local zenon6.ini, they are overwritten as 

soon as the confirmation message is answered with "Yes" on login. 

CONFORMATION DIALOG 

Changes to the configuration are only completed after corresponding confirmation in a confirmation 

dialog: 

 Click the YES button to apply your configurations. 

 Clicking on the Cancel button returns to configuration. 

 

MESSAGES 

For explanations about system messages and error messages see chapter Message at registration (on 

page 100). 

  Information 

You can find notes on error messages from strong encryption in: 

Network handbook -> Strong encryption of network communication chapter -> 

Error messages section. 
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7.1.1.3 Listening ports 

In this tab, the ports that are used by zenon can be individually configured for individual applications. 

The settings that were saved in the respective zenon6.ini file are used in the Runtime. 

Attention 

Note the following during configuration: 

 Changes in this tab can trigger a restart of the computer. 

Note: This is shown by a corresponding dialog. If this dialog is closed by 

clicking on the No button, no changes are made. 

 All computers with which communication takes place must have the same 

settings. 

 These settings are not available under Windows CE. 

 If an IP address is defined, it must be amended if the setting for IPv6 is 

activated or deactivated 

 If a defined network address is not connected at the time when the service 

is started, no Listening Socket is opened 

 Error messages are not logged in the Diagnosis Server but in the Windows 

Application Event Log. 
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LISTENING PORTS DIALOG 

 

Note: This dialog is only available in English.  

The buttons are displayed in the system language of the computer. 

Parameter Description 

Services List with all configurable applications. The selected 

application can be configured by means of the options in 

Settings. 
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Parameter Description 

Settings Settings for the application selected in Services. 

All network adapters All available network cards are used for the binding of the 

Listening ports. 

Single network adapter The local address defined here is used for the binding of the 

Listening ports. 

Supported protocols: 

 IPv4 

 IPv6 

Single network adapter The first address of the network card defined here is used for 

the binding of the Listening ports. 

Default port The standard port number is used for the binding. 

Customer port The port number entered here is used for the binding. 

CLOSE DIALOG 

Parameter Description 

OK Applies all changes in all tabs and closes the dialog. 

Cancel Discards all changes in all tabs and closes the dialog. 

STANDARD PORTS 

Assignment of the standard ports to applications: 

ZENON 

Application Standard port 

Network Service 1100 

Transport Service 1101 

WEB Service Classic 1102 

DB Service 1103 

SQL Browser Service,  

(for distributed engineering in the Editor) 

1434 
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Application Standard port 

zenAdminSrv.exe  50777 

zenLicTransfer  

(License Transfer Service) 

50784 

Logging Service 50780 

SNMP Trap Service 50782 

WEB Service Tunneling 8080 

ZENON LOGIC 

Application Standard port 

Assigned port for zenon Logic or straton depends on the project and 

service. 

E.g.: First zenon Logic project used 1200 and 9000, second project 1201 

and 9001 etc. 

1200 - 1210 

4500 - 4510 

7000 - 7010 

9000 - 9010 

ZENON ANALYZER 

Application Standard port 

Administration Service 50777 

Analyzer Connector Service 50778 

Analyzer License Service 50779 

ZAMS 50781 

DRIVERS 

Application Standard port 

Driver Simulation  6000 - 6020 

Process Gateway OPC Server  135 

Process Gateway SNMP  161 

Process Gateway Modbus  502 

Process Gateway IEC60870-5 104 slave  2402 
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Application Standard port 

Process Gateway DEC  5555 

Process Gateway DNP3 Slave  20000 

SERVICE GRID 

Application Standard port 

Service Grid API 9400 

Hub Controller 9410 

Data Hub 9411 

Hub Controller: Dedicated port for connection to Data Hub 9412 

Configuration Backend 9420 

Identity Service 9430 

Policy Service 9440 

 
 

7.1.1.4 Startup 

Programs and services can be started automatically using the zenStartupMgr service. 

  Hint 

Use the possibility to start zenon Runtime automatically as a service. 



Startup Tool 

 

87 | 142 

 

 

DIALOG SERVICE STARTUP 

 

Parameter Description 

Service startup Autostart for services. Makes it possible to start programs as a service. 

Liste Services List of configured services. 

New Opens dialog to select a program. 

Edit Opens the dialog to edit the highlighted entry. 

Delete Deletes the highlighted entry. 
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Parameter Description 

Autostart Section for the activation of Autostart. 

Connector Container Autostart for Connector Container, for zenon Analyzer, Web Engine or 

Remote Runtime for example. 

 Active: The Connector Container is automatically started when a 

user logs in. 

Only available if the folder with the Connector Container is in the same 

path as the Startup Tool.  

Example:  

The Startup Tool is in %ProgramFiles(x86)%\Common 

Files\COPA-DATA\STARTUP.  

The Connector is searched for in %ProgramFiles(x86)%\Common 

Files\COPA-DATA\Connectors. 

OK Applies all changes in all tabs and closes the dialog. 

Cancel Discards all changes in all tabs and closes the dialog. 

 

SELECT PROGRAM DIALOG 

 

Parameter Description 

Program Path to the program that is to be started as a service. Clicking on the ... 

button opens the file selection dialog. 

Maximum length: 259 characters 

Parameters Input of parameters. The possible parameters depend on the program 

selected in the Program option. 

Maximum length: 259 characters 
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Parameter Description 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

START RUNTIME AS A SERVICE 

To start Runtime as a service: 

1. Register the file zenStartupMgr.exe as a service. 

2. Configure the properties for sign-in. 

3. Start, if necessary, Remote Transport with zenStartupMgr. 

4. Define the Runtime to be started in the Startup Tool. 

5. Configure a start delay for zenon Runtime if you are using a dongle license. 

You can find details on this in the Runtime manual in the Starting Runtime as a service chapter. 

Attention: If Runtime is started using the zenStartupMgr, it can no longer be stopped or restarted 

by users. 

REGISTER SERVICE 

To register zenStartupMgr.exe as a service: 

1. Open the command line. 

2. You can navigate to the location of the zenStartupMgr.exe file. 

 For native 32-bit OS: %ProgramFiles%\Common Files\COPA-DATA\zenStartupMgr 

 For 64-bit OS: 

64-bit folder: %ProgramFiles%\Common Files\COPA-DATA\zenStartupMgr 

32-bit folder: %ProgramFiles(x86)%\Common Files\COPA-DATA\zenStartupMgr 

3. Register the file as a service with the zenStartupMgr.exe –service command. 

Note: The service, if it is already running, is first stopped and then registered. If 

zenStartupMgr is running, it is closed. 

CONFIGURE SERVICE FOR THE USE OF MANY DRIVERS 

Windows as an operating system limits the number of windows that can be created due to its fixed, 

reserved desktop memory, depending on the version and possible interaction with the desktop. 
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Version/action Interactive Desktop Non-Interactive Desktop 

Windows 7 32-Bit 12 MB 512 KB 

Windows 7/Windows Server 2008 R2 64-bit 20 MB 768 KB 

zenon drivers each need several windows. The number of drivers that can be used can be influenced 

using the Allow data exchange between service and desktop option in the properties of the 

service. 

 Inactive:  

A maximum of 20 drivers can be started. 

 Active:  

As many drivers as there are in a Runtime started as a user process can be started. 

To activate the Allow data exchange between service and desktop option: 

1. Open the Windows Service Manager. 

2. Open the properties of the zenStartupMgr service. 

3. Go to the Login tab. 

 

4. Activate the Allow data exchange between service and desktop. 

This service must be configured to automatic start type. With the service active, the user 

logged on to the computer is notified if the zenon Runtime as a service opens an additional 

window, for example in the event of a new alarm and active status line. 

Note Windows 8/Server 2012: In order for the service to be able to be started, the entry 

must be set correctly in the Windows registry: 

a) Go to the entry HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Windows. 

b) Open or create the DWORD value NoInteractiveServices. 
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c) Set the decimal value of 1 to 0. 

5. To stop Runtime messages being displayed on the desktop: 

Deactivate the Detection of inactive services service. 
 

7.1.2 Item 

The menu Item has the following entries: 

Entry Function 

New Creates a new entry in the list and opens dialog Properties (on page 91). 

Delete Deletes the selected entry after confirming a confirmation message. 

Properties Opens Properties (on page 91) dialog for the selected entry. 

 
 

7.1.3 Help 

Help menu to call up: 

 Help:  

Opens the online help for the Startup Tool. 

 Info about:  

Shows version information for the Startup Tool. 

 Update Help: 

Starts the Documentation-Download-Tool (on page 47). 
 

7.2 Properties 

The parameters for each entry are defined in the Properties dialog: 

Entry Function 

General General settings 

Database Settings for the database connection 

Extras Settings for registering ActiveX controls (OCX) and COM servers (DLL) and for 

starting additional programs or batch files. 
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7.2.1 General 

In this part, details about the zenon versions are entered. The path to the 32-bit version of zenon is 

absolutely necessary. If the Startup Tool detects a 64-bit version, the path to the 64-bit version is also 

cleared for an entry. 

 

The following properties are available for a selected entry: 

GENERAL 

Parameter Description 

Name Distinct name as it should be displayed in the list. This entry is 

absolutely essential. 
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Parameter Description 

Version The Startup Tool automatically enters the zenon version number 

here. To do this, a program path must be entered beforehand 

under Program Path. 

Programm path (32-bit) Program path in which the executable 32-bit version of the zenon 

file (Zenrt32.exe) is located. 

If a 64-bit version of zenon is detected here, the Programm path 

(64-bit)  property is also unlocked for input. 

Programm path (64-bit) Program path in which the executable 64-bit version of the zenon 

file (Zenrt32.exe) is located. 

Input only possible if the path to the 32-bit version was stated and a 

64-bit version was detected by zenon. 

As soon as both paths have been entered correctly, the buttons for 

starting Editor and Runtime are divided into two buttons, one for 

32-bit and one for 64-bit. 

Overwrite INI settings Active: The settings of this dialog are always used when the Editor is 

started. Changes made while working with the Editor are discarded. 

Workspace, Editor-Project, Runtime-Project and Runtime-Path 

are affected. 

Take over INI settings Active: All amended settings for Workspace, Editor-Project, 

Runtime-Project and Runtime-Path are saved in zenon6.ini after 

the Editor is closed, read into the Startup Tool and used for the next 

start.  

EDITOR 

Parameter Description 

Workspace The desired workspace when the Editor is started. As soon as this is 

entered, all projects that are in this workspace are displayed 

automatically in the drop-down list under  Editor-Projekt.  

Editor-Project Select the project which should be active after the Editor started. 

RUNTIME 

Parameter Description 

Runtime-Project Project that is set as the start project for Runtime. 
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Parameter Description 

Runtime-Path Path of the project. If the Runtime project is part of the workspace, 

the path is entered automatically.  

 

  Info 

UNKNOWN PARAMETERS? 

If the settings for the workspace are unknown, use the following approach. 

1. Enter Name, Program Path and Workspace 

2. Leave Editor-Project, Runtime-Project and Runtime-Path  

3. Activate Read back the INI settings  

4. Leave dialog by clicking OK. 

After the Editor has been started and closed once, the start settings are 

automatically taken from the INI file. 

 
 

7.2.2 Database 

Define the database properties. It is possible to use different SQL instances for the different entries 

(zenon versions). 

  Attention 

From version 6.51, the SQL instance can be defined and the password is saved in 

encrypted form. New entries have a higher priority than existing entries. 

Compatibility: If nothing is changed, the existing entries remain valid. 

However, if an entry for version 6.51 or higher is amended, the new entries are 

valid. Older versions must be maintained separately. You can find the settings 

for version previous to 6.51 in the Database before version 6.51 (on page 97) 

chapter. 

Display dialog: The display of the dialogs is automatically amended to the 

selected version (before 6.51 (on page 97), from 6.51). 
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Entry Function 

Read from zenDB.ini Clicking on the button reads off the settings from the zenDB.ini file and 

the following fields are automatically filled: 

 SQL instance 

 DB Path 

 User 

 Password 

Clear all fields All input field are cleared. 

Empty entries are not written to zenDB.ini at registering. 

SQL Instance Name of the SQL server instance which should be used. 

The name can be entered directly in the input field or can be selected 

from the drop-down list.  

Note: By clicking on the drop-down list the local computer is searched 

for instances which are then listed. The search may take some time. 

DB Path Path for the SQL database of the zenon projects.  

For example: %ProgramData%\COPA-DATA\SQL\ 

Attention: Different SQL Servers (for example 2008R2, 2012 and 2017) 

must use separate paths. 
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Entry Function 

Background: When converting projects the GUID stays the same. If the 

same folders are used, both instances overwrite each others database 

files. 

User User name for the database. 

Necessary rights 

In SQL Server, the user must have the following Server roles: 

 public 

 sysadmin 

Password Password of the user. It is stored encrypted. The entry length is always 

displayed with 20 characters regardless of the actual length. 

Note: 

 The encryption is done via the Startup Tool. 

 The database setting must be set using the Startup Tool. 

The password must also be amended on the SQL server for the 

zenOnSrv user. 

These settings are saved in the zenDB.ini file. 
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7.2.2.1 Database previous version 6.51 

Setting of the database property before zenon 6.51: 

 

Entry Function 

Read from 

zenDB.ini 

Clicking on the button reads off the settings from the zenDB.ini file and 

automatically fills the  Provider and DB Path fields. 

Clear all fields All input field are cleared.  

Empty entries are not written to zenDB.ini at registering. 

Provider Connection to the SQL instance. Important information: 

 Instance name  

 Used provider 

 User name  

 User password  

For example:  

Provider=SQLNCLI.1; 

Password=srv_000; 

Persist Security Info=False; 

User ID=zenOnSrv; 

Initial Catalog=%s; 
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Entry Function 

Data Source=localhost\ZENON_DEV; 

DB Path Path for the SQL database of the zenon projects.   

For example:  %ProgramData%\COPA-DATA\SQL\ 

Attention: It is necessary that SQL Server 2005 and SQL Server 2008 R2 

use different folders.  

Background: When converting projects the GUID stays the same. If the 

same folders are used, both instances overwrite each others database files. 

 

Attention 

The entry for Provider differs in this dialog from the entry in the zenDB.ini. 

Dialog: String starts with Provider=...  

zenDB.ini: String starts with Provider=Provider=...  
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7.2.3 Extras 

Here, you create ActiveX controls (*.ocx) or COM servers (*.dll) which should be registered together 

with the respective zenon version. These OCX and DLL files can originate from any source, i.e. they 

can be written by you or come from other providers. Additionally you can define programs which are 

carried out before the starting or after the closing the Editor or the Runtime. 

 

REGISTRATION ACTIVEX CONTROLS - COM SERVER 

All files listed here are automatically registered together with the respective zenon version - 

independent of the central setting (on page 68) register. 

Parameter Description 

Filename/Filepath List of all files to be registered 

Add Opens the Windows dialog to select a file to be registered. There 

you can select OCX or DLL files individually and add them to the list. 

First select the wanted file type (OCX or DLL).   

All files are saved with path information. If the path changes, 

remove the link with Remove and create a new one. 

Remove Removes all selected entries from the selection list of the files to be 

registered.  

Attention: the selected entries are deleted without requesting 
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Parameter Description 

confirmation. 

PRE-START AND POST-START PROGRAMS 

Pre Start and Post Start allow you to define programs and batch files that are to be executed before 

starting or after ending zenon.  

Parameter Description 

Pre Start External program that should be started, before the Editor or 

Runtime is started. Clicking on ... opens the Windows selection 

dialog to select a program or batch file to be executed. 

Attention: Editor or Runtime are only started if this program is 

ended again. 

Post Start External program that should be started, after the Editor or 

Runtime is closed. 

Clicking on ... opens the Windows selection dialog to select a 

program or batch file to be executed. 

Attention: Post Start is only called up if the Read back the INI 

settings (Item->Properties->General) option has been 

activated. 

 
 

7.3 Message at registering 

POP-UP AT REGISTERING 

Message Meaning 

You have changed the IPv6 setting. All internal 

TCP/IP connections will be switched to 

IPv6/IPv4. 

To ensure that all affected components are 

properly switched you have to restart the 

computer! You will also have to change this 

setting on all connected station! 

Do you really want to apply the change? 

You change the settings for the IP protocol 

from IPv4 to IPv6 or vice versa.  

After the changes you must restart the 

computer for all services to be adapted 

accordingly.  The change must also be 

carried out on all connected stations. 

These changes are written to zenon6.ini or 

zenon.ini together with the registration and 

overwrite any manual configurations.  
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Message Meaning 

Gerneral network configuration settings will be 

changed.  

You have to restart the runtime to apply the 

changes! 

Attention: Do not forget to adept the settings on 

other stations as well. 

Apply settings. 

Are you sure this is your intent? 

You change general settings (on page 76) in 

the same ways as time outs. 

These changes are written to zenon6.ini or 

zenon.ini together with the registration and 

overwrite any manual configurations.  

You must adapted changed settings for all 

Runtimes. 

MESSAGE AT REGISTERING 

At registering the service all steps are displayed in an own window which closes after 4 seconds 

automatically. When an error occurs, a warning message informs you about the cause. After 

confirming the message the procedure is canceled. zenon is not started. Possible error messages: 

Message Reason Hint 

Couldn´t find 

zenNetSrv 

Service! 

File zenNetSrv.exe is missing from the 

zenon program folder or a wrong 

version is available. 

Most of the time the fastest and 

safest solution is a new installation 

of zenon. 

zenNetSrv.exe still 

running! 
The service zenNetSrv.exe could not be 

stopped. 

It is possible that a security tool is 

running on the computer which 

prevents the access.  

Couldn´t find 

zenSysSrv  

Service! 

File zenNetSrv.exe is missing from the 

zenon program folder or a wrong 

version is available. 

Most of the time the fastest and 

safest solution is a new installation 

of zenon. 

zenSysSrv.exe still 

running! 
The service zenSysSrv.exe could not be 

stopped. 

It is possible that a security tool is 

running on the computer which 

prevents the access.  

 
 

7.4 Tools 

Tools allow the starting of applications from the Startup Tool. 
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You can find the tools in their own dialog. You can get to this by clicking on the Tools dialog in the 

Startup Tool: 

 

Depending on the application, parameters for the command line can also be transferred. The tools 

that are available depend on the zenon products and operating system installed. 

The tools that are available depend on which applications are installed and which application has 

been selected in the start dialog.  

The following are generally available: 

 Available 32-bit applications: List of available 32-bit applications. 

 Available 64-bit applications: List of available 64-bit applications. 

 Available applications (current folder): List of the applications available in the current folder. 
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 Command line parameters: Entry of the application and parameter for starting tools by 

means of command line entry. 

Empty areas are hidden. The space for hidden areas is used by the remaining ones. If, for example, 

only zenon Analyzer is installed but no zenon application, the areas for 32-bit and 64-bit are hidden: 

 

If no tools are available, all areas are hidden and displayed as empty. 
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7.4.1 Options 

START EXTERNAL APPLICATION DIALOG 

 

AVAILABLE 32-BIT APPLICATIONS 

List of available 32-bit applications. 

Option Description 

Keyblock Runtime Start Starts the currently-active Runtime with the 

Keyblock option. All Windows system keys thus 

remain blocked when Runtime is started. 
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Option Description 

Note the Information in the Keyblock Runtime Start 

(on page 56) chapter in the Runtime manual. 

Name of the EXE file: zenKeyBlock.exe 

OPC Server Starts the zenon OPC server. 

Name of the EXE file: zenOPCSrv.exe 

Process Gateway Starts the Process Gateway. Note the information in 

relation to configuration of the parameters. 

Name of the EXE file: zenProcGateway.exe 

Parameter: /ini:MyConfig.INI  

Replace MyConfig.INI with the correct name of 

your INI file 

Redundancy Management Tool Starts the zenon Redundancy Management Tool. 

Name of the EXE file: zenon_redman.exe 

Remote runtime update Opens the dialog to configure the Remote Runtime 

Update for CE. 

Name of the EXE file: UpdateCE.exe 

SharpDevelop IDE Start the SharpDevelop IDE for creating AddIns. 

Name of the EXE file: SharpDevelop.exe 

SQL Server communication test tool for 

zenDBSrv 
Opens the dialog to access to the zenon Database 

Admin client. 

Name of the EXE file: zenDBAdmin.exe 

zenon Logic Compare projects Opens the dialog to compare two zenon Logic 

projects. 

Name of the EXE file: K5DiffTest.exe 

zenon Logic Library Manager Opens the dialog of the zenon Logic Library 

Manager. 

Name of the EXE file: K5LibMan.exe 

zenon Logic License Manager Opens the zenon Logic License Manager. 

Name of the EXE file: K5LicMan.exe 
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Option Description 

zenon Logic Monitoring Opens the zenon Logic monitoring. 

Name of the EXE file: W5Monitoring.exe 

zenon Logic Runtime Starts zenon Logic Runtime. You can also find 

further information in the Starting Runtime chapter 

in the zenon Logic Runtime manual. 

Name of the EXE file: STRATONRT.exe 

zenon Logic Runtime Manager Starts the zenon Logic Runtime Manager, which 

administers all stand alone/manually-started zenon 

Logic Runtime projects on your computer. 

Name of the EXE file: autorun.exe 

AVAILABLE 64-BIT APPLICATIONS 

List of available 64-bit applications. 

3D Configurator Opens the 3D configurator. 3D files are loaded 

in this project configuration environment. 

Name of the EXE file: zen3DConfig.exe 

Keyblock Runtime Start Starts the currently-active Runtime with the 

Keyblock option. All Windows system keys thus 

remain blocked when Runtime is started. 

Note the Information in the Keyblock Runtime Start 

(on page 56) chapter in the Runtime manual. 

Name of the EXE file: zenKeyBlock.exe 

zenon Logic Compare projects Opens the dialog to compare two zenon Logic 

projects. 

Name of the EXE file: K5DiffTest.exe 

zenon Logic Library Manager Opens the dialog of the zenon Logic Library 

Manager. 

Name of the EXE file: K5LibMan.exe 

zenon Logic License Manager Opens the zenon Logic License Manager. 

Name of the EXE file: K5LicMan.exe 

zenon Logic Monitoring Opens the zenon Logic monitoring. 
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3D Configurator Opens the 3D configurator. 3D files are loaded 

in this project configuration environment. 

Name of the EXE file: zen3DConfig.exe 

Name of the EXE file: W5Monitoring.exe 

AVAILABLE APPLICATIONS (CURRENT FOLDER) 

List of the applications available in the current folder. 

Option Description 

Diagviewer Starts the Diagnosis Viewer (on page 7). 

Name of the EXE file: DiagViewer.exe 

License Manager Opens the  License Manager. 

Name of the EXE file: LicenseManager.exe 

SCADA Runtime Connector Opens the SCADA Runtime Connector. 

Service Node Configuration Tool  Opens the tool for service node configuration (on 

page 59) in the Service Grid. 

System Information Collector Starts the System Information Collector (on page 

119). 

Name of the EXE file: SIC.exe 

Web Engine Deployment Tool Starts the Web Engine Deployment Tool. You can 

also find further information in the Deployment of 

the web engine chapter in the zenon Web Server 

manual. 

Name of the EXE file: 

WebEngineDeploymentTool.exe 

Parameters: none 

COMMAND LINE PARAMETERS 

Entry of the application and parameter for starting tools by means of command line entry. 
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Command line parameters Entry of the parameters for the command line 

(on page 116). 

Syntax: [Name of the EXE] /[Parameters] 

Attention: The name of the EXE file must be 

given. 

CLOSE DIALOG 

Start Closes the dialog and starts the selected 

application with the parameters entered. 

Cancel Closes the dialog without starting an application. 

 
 

7.4.2 Starting the tool 

To start a tool: 

1. Open the zenon Startup Tool (on page 67). 

2. Click on Tools. 
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The dialog for configuring the zenon Tools is opened. 

 

3. Select the desired tool. 

4. Enter, if required, the following in the Command line parameters field: 

[Tool].EXE /[Parameter]  

Attention: The parameters alone are not sufficient. There must be a call to the respective 

EXE. 

5. Click on Start. 

AVAILABLE .EXE FILES 

Application EXE Remark 

Diagviewer DiagViewer.exe  
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Application EXE Remark 

Keyblock Runtime 

Start 

zenKeyBlock.exe No parameters. 

Licensing LizenzKnd.exe Parameter: 

 request 

 silent 

 sernum:<nummer

> 

 actkey:<key> 

 mailto:<addr> 

OPC Server zenOPCSrv.exe No parameters. 

Process Gateway zenOnOnline.exe  

Process Gateway zenProcGateway.exe Name of the INI file: 

/ini:MyConfig.INI 

Replace MyConfig.INI 

with the correct name of 

your INI file. 

Parameter: 

 -ADAPTER:  

Command line 

input 

parameters/INI 

settings for 

adapter name 

 -DELAY: 

command line 

input 

parameters/INI 

settings for 

waiting time. 

Default: 10 

 - ? (help):  

Show help 

Redundancy 

Management Tool 

zenon_redman.exe  
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Application EXE Remark 

Remote runtime 

update 

UpdateCE.exe No parameters. 

SQL Server 

communication test 

tool for zenDbSrv 

zenDBAdmin.exe Parameter: 

 -s: Silent. 

 -checkconnections

tring 

 -createsqluser 

 -c: Computer 

name 

 -exists: Check to 

see whether the 

project exists. 

 -delete: Delete 

project. 

 -backup: Create 

backup. 

Password, 

description and 

the path to the 

file must be 

specified. 

 -restore: Restoring 

from backup file.  

The password 

and the path to 

the file must be 

specified. 

 -password: 

Password 

 -backupfile: File 

for backup. 

 -desc: Description. 

 - reload: Reload 

project. 

System Information 

Collector 

SIC.exe Parameter: 

 forcedbaction:  
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Application EXE Remark 

Always allow SQL 

Attach/Detach 

 externalxmlenable

: 

Allow loading 

from external 

Query-XML 

 developer:  

Quick scan 

Web Engine 

Deployment Tool 

WebEngineDeploymentTool.exe No parameters. 

zenon Logic 

Compare projects 

K5DiffTest.exe  

zenon Logic Library 

Manager 

K5LibMan.exe  

zenon Logic Licence 

Manager 

K5LicMan.exe  

zenon Logic 

Monitoring 

W5Monitoring.exe  

zenon Logic Runtime STRATONRT.exe  

zenon Logic Runtime 

Manager 

StratonRT_Manager.exe  

 
 

7.4.2.1 Applications - EXE files - parameters 

Internal Information: Names of the EXE files and possible parameters for the following applications. 

Information for customers is in the Startup Tool (on page 67) manual, Start tool (on page 108) 

chapter. 

Application EXE Parameters 

ArvView ArvView.exe   

Diagviewer DiagViewer.exe   

Driver information Driverinfo.exe   
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Application EXE Parameters 

Keyblock Runtime 

Start 

zenKeyBlock.exe   

Konvertor Konvertor.exe   

LauerTakeOff LauerTakeOff.exe   

Licensing LizenzKnd.exe   -request 

 -silent 

 -sernum:<nummer> 

 -actkey:<key> 

 -mailto:<addr> 

LizenzCopaData LizenzCopaData.exe   

LizenzKnd_PMI LizenzKnd_PMI.exe   

LizenzLauer LizenzLauer.exe   

MMCfg MMCfg.exe   

MsgCtrlDB MsgCtrlDB.exe   

NETEDIT NETEDIT.EXE   

Network 

communication 

encryption 

zenWebCryptConfig.exe   

oledb_test oledb_test.exe   

OnlineSQL OnlineSQL.exe   

OPC Server zenOPCSrv.exe   

Process Gateway zenOnOnline.exe   

Process Gateway zenProcGateway.exe  Name of the INI file: 

/ini:MyConfig.INI 

Replace MyConfig.INI with the 

correct name of your INI file. 

Parameter: 

 -ADAPTER:  

Command line input 
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Application EXE Parameters 

parameters/INI settings for 

adapter name 

 -DELAY: Command line input 

parameters/INI settings for 

waiting time. 

Default: 10 

 - ? (help):  

Show help 

Redundancy 

Management Tool 

zenon_redman.exe   

Remote runtime 

update 

UpdateCE.exe   

ResourceGenie CD_ResourceGenie.exe   

SQL Server 

communication test 

tool for zenDbSrv 

zenDBAdmin.exe   -s: Silent. 

 -checkconnectionstring 

 -createsqluser 

 -c: Computer name 

 -exists: Check to see whether 

the project exists. 

 -delete: Delete project. 

 -backup: Create backup. 

Password, description and the 

path to the file must be 

specified. 

 -restore: Restoring from 

backup file.  

The password and the path 

to the file must be specified. 

 -password: Password 

 -backupfile: File for backup. 

 -desc: Description. 

 - reload: Reload project.  

SrvSetup SrvSetup.exe   
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Application EXE Parameters 

STRATON_for_zenOn STRATON_for_zenOn.exe   

System Information 

Collector 

SIC.exe   forcedbaction:  

Always allow SQL 

Attach/Detach 

 externalxmlenable: 

Allow loading from external 

Query-XML 

 developer:  

Quick scan 

Web Engine 

Deployment Tool 

WebEngineDeploymentTool.exe  -- 

zenNetCli zenNetCli.exe   

zenon Logic 

Compare projects 

K5DiffTest.exe   

zenon Logic 

Configuration 

CDRtHALConfig_EXE.exe   

zenon Logic Global 

Binding Editor 

W5Binding.exe   

zenon Logic Library 

Manager 

K5LibMan.exe   

zenon Logic Licence 

Manager 

K5LicMan.exe   

zenon Logic 

Monitoring 

W5Monitoring.exe   

zenon Logic Runtime STRATONRT.exe   

zenon Logic Runtime 

Manager 

StratonRT_Manager.exe   

Key: 

 --: No parameter 
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7.5 Command line 

You can also operate the Startup Tool using the command line. To do this, zenon_Startup.exe must 

be in the system path. You can find the file in the following folder: %Program Files%\Common 

Files\COPA-DATA\STARTUP  

In the commando line you can: 

 create new entries (on page 116) 

 reorganize (on page 119) existing entries (e.g. after older versions have been deleted) 

 register (on page 119) entries 
 

7.5.1 Parameters 

The input is started with zenon_Startup.exe followed by a Parameter and possible field names.  

Parameters: 

Parameter

s 

Function Field name Return value 

-new creates a new entry. yes, list see also new 

(on page 116) 

0 or 1 

-reg registers services Name of the entry none 

-reorg checks and reorganizes existing entries not available none 

If the startup tool is only called up with -reg, only the version is re-registered. In doing so, zenon6.ini 

is accessed on a read-only basis only. The version defined in the [PATH] section is registered; all 

parameters are taken from zenon6.ini. 

USING SEVERAL PARAMETERS AT ONCE: 

It is possible to use several parameters at once. If several -new parameters are used at once, the 

return value cannot be evaluated unambiguously. 

In general when several parameters are used, it is proceeded in the following order: 

1. –new: Create new entries. 

2. –reg: Register the stated entry.  

3. –reorg: Remove all invalid entries for deleted zenon versions. 
 

7.5.1.1 new - Creating new entries 

The -new parameter is used for creating new entries. It needs at least two field names: 
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 NAME as unique name for the entry 

If the name of the entry is already available, no entry is created. 

 PATH as path in which zenon is stored. 

SYNTAX 

The syntax is structured as follows: zenon_Startup.exe -> Parameter > Field name="TEXT"  

1. zenon_Startup.exe 

2. Space 

3. Parameters 

4. Space 

5. Field name 

6. = character 

7. opening quotation marks 

8. Text 

9. closing quotation marks 

  Example 

zenon_Startup.exe -new NAME="new entry" PATH="C:\example folder\test" 

FIELD NAME 

The following field names can be used: 

Field name Mandato

ry field 

Description 

NAME X Unique name of the entry. 

E.g.: NAME="Test" 

PATH X The user path in which zenon is saved. 

E.g.: PATH="C:\Program Files (x86)\COPA-DATA\zenon 7.10 

SP0" 

PATH64 - The application path, in which the 64-bit version of zenon is 

located. 

E.g.: PATH="C:\Program Files\COPA-DATA\zenon 7.10 SP0" 

PROJECT_RT - Name of the Runtime project which should be started. 
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Field name Mandato

ry field 

Description 

E.g.: PROJECT_RT="test project" 

PROJECT_RT_PATH - The Runtime folder of the project (see PROJECT_RT). 

E.g.: 

PROJECT_RT_PATH="C:\Users\Public\Documents\zenon_Proje

cts\Test Project" 

PROJECT_ED - The project which should be activated in the Editor. 

E.g.: PROJECT_ED="test project" 

WSP - The workspace with which the Editor should be loaded. 

E.g.: 

WSP="C:\Users\Public\Documents\zenon_Projects\DEMO760.

WSP6" 

SQLSRV - Name of the SQL Server which should be used by the Editor. 

E.g.: SQLSRV="MSSQL$ZENON_DEV" 

PROVIDER - Provider string for the initialization of the SQL connection. 

E.g.: PROVIDER="Provider=SQLNCLI.1;Password=000;Persist 

Security Info=False;User ID=zenOnSrv;Initial Catalog=%s;Data 

Source=localhost\ZENON_DEV;" 

DBPATH - Path for the SQL database which should be used 

E.g.: DBPATH="C:\ProgramData\COPA-DATA\SQL\" 

PRESTART - Program call which is executed before the start of the Editor 

or the Runtime or the registering of this version. 

e.g.: PRESTART="C:\zenon 

Versions\zenon8.20\Dlls\zenVNCCli.exe" 

POSTSTART - Program call which is executed after the Editor is closed. 

E.g.: POSTSTART="C:\zenon 

Versions\zenon8.20\Dlls\zenVNCCli.exe" 

Attention: Post Start is only executed when in the Startup 

Tool or in Startup.ini option Read back the INI settings 

(Item -> Properties -> General) is activated. 

The field names are separated by spaces. 
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  Information 

Paths with spaces must always be put between parentheses. 

RETURN VALUES 

 0: Execution faultless 

 1: Entry could not be created 
 

7.5.1.2 reorg - reorganizing of entries 

Parameter -reorg checks all entries to see whether the linked zenon version is still available in the file 

system. If the application files are no longer found, the entry is finally deleted from the Startup Tool.  

The command does not provide a return value. After execution the Startup Tool is started. 

Example: zenon_Startup.exe -reorg 
 

7.5.1.3 reg - register entries 

The –reg parameter registers all necessary services in the folder of the stated entry. It is called up via: 

 -reg "Name of the entry" 

If the Startup Tool has already been started, nothing is registered but the Startup Tool is moved to 

the foreground.  

The command does not provide a return value. 

  Example 

zenon_Startup.exe -reg "version 6750"  

Registers version 7.50.  

Prerequisite: there is an entry with this name in the Startup Tool.  

 
 

8 System Information Collector 

When solving problems, COPA-DATA Support may ask for the relevant data about your operating 

system and zenon. The easiest way for you to create this data is in an automated manner with the 

System Information Collector and then sending this to Support.  
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8.1 Starting the System Information Collector 

The System Information Collector is also installed when zenon is installed.  It is located at: 

 Computer in the path: %Program Files (x86)%\Common Files\COPA-DATA\STARTUP 

 Installation medium in the following path \AdditionalSoftware\COPA-DATA System 

Information Collector. 

To start the System Information Collector:  

1. Windows 8: enter SIC as a search term for Apps on the desktop  

Windows 7: go to Start/All Programs/zenon/Version Independent Tools   

or: start it from the installation medium  

2. Click on System Information Collector 

3. The System Information Collector starts 

 

MENU AND TOOLBAR  

MENU 

The following options are available to you in the menu: 

 File 
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 New Scan:  Opens the Start window. 

 Open: opens a saved report 

 Save: saves the currently-displayed report as a ZIP file 

 Exit: closes the System Information Collector 

 Edit 

 Copy: copies highlighted text to the clipboard 

 Find: opens a dialog to search the current report 

 View 

 Expand: expands all nodes 

 Collapse: closes all nodes  

 Help 

 About: Information on the program version 

With the exception of Exit and About, all options are also available from the toolbar. 

TOOL BAR 

 

Symbol Description 

Home  

New Scan 
Opens the Start window. 

Open Opens a saved report. 

Save Saves the currently-displayed report as a ZIP file. 

Copy Copies highlighted text to the clipboard. 

Find Opens a dialog to search the current report 

Expand Expands all nodes. 

Collapse Closes all nodes. 

 
 

8.2 Collecting information 

To collect information in an automated manner: 

1. Start (on page 120) the System Information Collector 

2. Select one of the four options by clicking on the corresponding button 
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 Full: collects information about the system and zenon. Dump files are not collected 

 System: collects information about the system only 

 Scada: collects information about zenon, without dump files  

 Scada with dumpfiles: collects information about zenon and includes dump files 
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3. The System Information Collector creates a report with the desired information 
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4. The completed report is displayed in the main window 

 

 
 

8.3 Using the information 

All information collected is displayed in the System Information Collector. They can: 

 Save the report  

 Navigate through the report and search for certain information 
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 Highlight selected information and copy it to the clipboard  

 

SAVING A REPORT 

To save a report: 

1. Click on the Save symbol or the Save command in the File menu  

2. The dialog for voluntary entry of a password for the encryption of a report opens 

3. the dialog for selecting a folder and file name is opened 

4. The report is saved as a ZIP file 

OPEN REPORT 

To open a saved report: 

1. Click on the Folder symbol in the toolbar 

2. Select the report 

3. If you have entered a password for the encryption of the report when saving, enter it again 

now or jump the step by clicking on OK 

4. The report is opened 
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SAVING SELECTED INFORMATION 

To saved selected information only: 

1. highlight the relevant information. 

2. Click on the Copy symbol or the Copy command in the Edit menu  

3. The selection is copied to the clipboard 

4. Insert the content into a text file and save this 

5. Repeat this process for further selected information  

 
 

8.4 Forward report to COPA-DATA 

The report can, depending on its size, be forwarded as an e--mail or uploaded to a defined save 

location to COPA-DATA. You can find out details on how you forward the report and which online 

save location you can use for this from your COPA-DATA Support contact.  
 

9 COPA-DATA PRP 

zenon supports the Parallel Redundancy Protocol (PRP) for hardware-redundant communication in an 

Ethernet network. The protocol is standardized in IEC 62439-3. 
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Every PRP node, a Dual Attached Node (DAN), is bound to two networks, here LAN A and LAN B. As 

PRP is a Layer-2 protocol, the protocol of the two networks must be identical on the MAC level. 

Therefore, this basically means that there must be no direct connection between the LANs. 

If one of the networks fails (e.g. if a cable is removed for one of the networks), this has no influence 

on the other one. The communication between PRP nodes remains seamless as long as one of the 

LANs is connected. 

The PRP communication is established directly on the OSI Layer 2 level, thus making it applicable for 

TCP, UDP, Ethernet Multicast (e.g. GOOSE) etc. Its use is independent of the zenon Editor and the 

zenon Runtime. No special configurations are required in zenon, and the use of PRP is “transparent” 

for <CD_PRODUKTNAME> modules, drivers, process gateways etc. The settings are only made in the 

components of the operating system. 

To use the protocol, the computer must have two network cards and be configured accordingly. You 

need the following for the use of PRP: 

 COPA-DATA PRP driver network service (for the network cards of the computer). 

 PRP configuration and diagnosis tool application. 

You can find this on the installation medium. You can find a detailed description of the required 

configuration steps in this manual in the installation and configuration (on page 129) chapter. 
 

9.1 System requirements 

PRP communication is supported for 100 Mbit/s Ethernet. 

Attention 

Windows 10 operating system: Versions earlier than Windows 10 version 1607 

are not supported. 

Note: In the Parallel Redundancy Protocol (PRP), the original Ethernet frames are supplemented by 

additional information (on OSI Layer 2), which is different in LAN A and LAN B. The non-PRP nodes 

(devices that do not support PRP) can be connected to the PRP network via a Redundancy Box 

(RedBox). 

Attention: 

 A direct Ethernet connection - between a PRP and a non-PRP node of the communication 

network - will lead to errors in the Ethernet communication. 

 Changing the assignment of network cards to LAN A and LAN B (or in the cabling) will lead 

the PRP communication to fail in all the PRP nodes. 
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GENERAL 

The PRP solution of COPA-DATA integrates both the (CDPrpFlt.sys) kernel driver as well as a system 

component - the network bridge. The network bridge (Network Bridge) is an integral part of the 

Windows operating system and thus dependent on the operating system version and the installed 

Windows updates. This solution entails increased dependency on the network drivers that the 

operating system uses: Firstly on network adapters and secondly on additional installed protocols or 

filter drivers. 

Additional driver software and network software from third-party manufacturers can lead to 

compatibility problems with the PRP protocol. Uninstall this software if PRP problems occur during 

communication. In the operating system, the list of the installed drivers can be displayed and 

managed by means of the system property in the Network and Internet properties group. Installed 

programs are displayed in the Programs system properties group and can be uninstalled there. 

Perform a Windows update too, in order to ensure that the operating system is up to date. 

Attention: Owing to described dependencies, there is no guarantee that the PRP solution works for 

every combination of operating system and network card type and/or additional third-party 

components. In the worst case, there can be an incompatibility between the network card driver and 

the COPA-DATA PRP implementation, which can only be solved technically by switching to a different 

adapter type (a different network card). 

 
 

9.2 Hardware requirements 

The following hardware requirements are applicable for communication via PRP: 

 The computer must be equipped with at least 2 network cards. 

 Only 100 Mbit/s Ethernet speed is supported.  

Both the two network cards as well as the Ethernet network components (routers and 

switches) must be set to 100 Mbit/s Ethernet. 

 Both network cards used for PRP must support Jumboframes. 

 For both the network cards used, the Offload tasks must be deactivated. 

 Configuration of the locally administered MAC address must be possible for both network 

cards for the purpose of changing the MAC address. 

Attention 

PRP communication is only supported within a redundant network. In doing so, 

two physical networks can be connected via PRP. 

A connection with additional Ethernet networks or to another PRP network (e.g. 

2x2 PRP) is not supported. 



COPA-DATA PRP 

 

129 | 142 

 

 

The cards configured for PRP can only be used in a PRP communication network. All other network 

cards of the computer can still be used for normal communication via Ethernet. 
 

9.3 Installation and configuration 

To prepare the computer for PRP installation: 

1. Switch the computer off and separate the computer from the power supply (physical reset). 

2. Restart the computer 

Carry out the following steps in the operating system: 

1. Configure your two existing network adapters. 

2. Create a network bridge (= Bridge) from the network adapters. 

3. Install the COPA-DATA PRP driver for the network bridge.  

4. Configure your PRP connection 

You can find a detailed description in the further chapters. 

NOTE: 

Note: 

 Administrator rights on the computer are required for installation. 

 The system must be restarted for the installation. 

 Note the instructions for the respective steps. 

 The packet sync of the network service supports networks up to 100 Mbit. 

 The PRP files can only be updated with a zenon main version or a service pack.  

Build versions are not in a position to do this. 

Attention 

Ensure that you carry out the configuration steps in the given sequence. 

 
 

9.3.1 Installation and configuration 

In the first step, amend the configuration of the operating system for both network adapters used. 

The configuration dialog and the naming of the enhanced properties depends on the network card 

used. 
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NETWORK ADAPTER 1 

Configure the first network adapter in the operating system. 

1. Open the Change adapter settings system setting. 

You can find these settings in the Control Panel => Network and Internet => Network and 

Sharing Center 

2. Select the desired network adapter. 

3. With the right mouse button, select the Properties entry in the context menu. 

The configuration dialog for the properties of the network adapter are opened. 

 

4. Click on the Configure ... button 

The properties window of the network adapter is opened. 
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5. Switch to the Advanced tab there. 

6. In the list of settings there, select the Jumbo Packet entry 

Note: The name of this entry may be different for each network card. 

 

7. Select a value in the Value drop-down list. 

Select the lowest available value that is greater than 1530 bytes. 

Attention: The Disabled setting must not be selected. 

8. Deactivate all Offload applications of the network adapter, e.g.: Checksum Offload, Large 

Send Offload etc. 

9. In the Advanced tab, select the Locally administered address setting. 

10. Enter a unique MAC address that begins with 0A in the Value: input field. You can change 

the address in the Value input field. 

The format of the MAC address depends on the hardware used. 

Examples: 

 0A:80:41:ae:fd:7e 

 0A-80-41-ae-fd-7e 

 0A8041aefd7e 

11. Ensure that the same MAC address is used for both connections used. 

 This MAC address must start with 0A. 

 The MAC address in the local network must be unique. 

12. Finish configuration of the network card by clicking on the OK button. 
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NETWORK ADAPTER 2 

Repeat the steps for the second network adapter. 

When entering the MAC address, ensure that the same MAC address as the one in the previous 

configuration is entered. 

Attention 

Ensure that 

 the same MAC address is used on both network adapters; 

 this MAC address begins with 0A; 

 And it is not used by any other computer in the local network. 

 
 

9.3.2 Installation and configuration 

In this step, you combine two network adapters with a network bridge. Amend the configuration for 

both network adapters used. 

Create a network bridge in the system settings. 

1. Open the Change adapter settings system setting. 

You can find these settings in the Control Panel => Network and Internet => Network and 

Sharing Center 

2. Select the two network adapters that you want to use for PRP communication. 

Note: The necessary configuration has already been carried out for both network adapters. 

A subsequent amendment to the configuration of a network adapter only becomes effective 

if you then create a new bridge. 

Attention: Both network adapters selected must be configured with the same MAC 

address! 

3. With the right mouse button, select the Bridge connections entry in the context menu. 

A network bridge is created for the selected network adapter. This is visualized in a dialog. 

 

4. The bridge created is displayed in the Control Panel: 

 
Attention: The bridge must only contain two adapters. 
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9.3.3 Installation and configuration 

In this step, you install the service system required for PRP communication. 

Install the COPA-DATA PRP driver 

1. Select the Bridge created. 

2. With the right mouse button, select the Properties entry in the context menu. 

The configuration dialog for the properties of the bridge is opened. 

 

3. Click on the Install button. 

The dialog to install a network feature is opened. 
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4. Select Service as the network feature to be installed. 

5. Click on the Add... button 

The dialog for the selection of the network service is opened. 

 

6. Click on the Data medium ... button 

The dialog to select the save location of the installation program for the network service is 

opened. 

 

7. Click on the Browse button. 

8. Go to the following folder on your local computer: 

 \Programs (x86)\Common Files\COPA-DATA\CDPrpFlt\  

for 32-bit operating systems.  

 \Programs\Common Files\COPA-DATA\CDPrpFlt\ 

for 64-bit operating systems.  
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9. Select the CDPrpFlt.inf file. 

Attention: Ensure that you select the correct installer for your operating system (32-bit or 

64-bit). 

10. Confirm the selection by clicking on OK. 

The dialog to select the network service is opened. 

 

11. Select the COPA-DATA PRP driver network service. 

12. Confirm your selection with OK. 
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 Confirm the Windows request for confirmation by clicking on the Install button. 

Attention: It may then be necessary to restart your computer. 

 
Note: This request for confirmation is not shown if you have already activated the "... 

always trust" box when installing zenon program components earlier. 

13. After successful installation (and restarting the computer) the service is visible in the 

properties window of the network adapter in the list of elements used. 

 

14. Ensure that the LAN connection and the network service COPA-DATA PRP driver are 

activated using the checkbox. 

Attention 

Ensure that use in the active system is not jeopardized by the required restart. 

 
 

9.3.4 Configuration of PRP connection (step 4 of 4) 

Before configuration, ensure that the LAN connection and the COPA-DATA PRP driver network service 

are activated. 



COPA-DATA PRP 

 

137 | 142 

 

 

PRP CONFIGURATION 

1. Start the program called PRPCfgDiag.exe. 

You can find this software on your computer in the following folder: C:\Program Files 

(x86)\Common Files\COPA-DATA\STARTUP. 

The PRP Configuration and Diagnostics dialog is opened. 

 
Note: The PRP Configuration and Diagnostics Tool is only available in English. You can find a 

detailed description of the PRP Configuration and Diagnostics Tools in the PRP configuration 

and diagnosis tool (on page 138). 

2. Click on the Configuration button. 

The dialog for the selection of the network adapter is opened. 

 
Note: The content of the drop-down list is based on the system settings. 

3. Select the network adapter for LAN_A and LAN_B from the drop-down list. 

Note: Ensure that for all PRP-compatible devices in the Ethernet network, the references 

between the physical network and LAN_A or LAN_B are configured the same. The plugs of 

the cables for LAN A and LAN B must not be mixed up. 

4. Confirm the assignment with OK. 

5. End the configuration by clicking on the Exit button. 

After these steps, the entire communication of this network adapter is carried out using the PRP 

protocol. This means that all applications on the computer that access the Ethernet via this interface 
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(TCP, UDP etc.) communicate with the support of PRP. No additional engineering is required in the 

applications; the use of PRP is “transparent” for them. 

Attention 

If the PRP communication does not function, make sure that all the System 

requirements (on page 127) and the Hardware requirement (on page 128) are 

met. 

You can also delete the network bridge, restart the computer (don’t forget 

Windows Updates) and carefully repeat all the configuration steps down to the 

last detail. 

 
 

9.4 PRP configuration and diagnosis tool 

The PRP Configuration and Diagnostics Tool performs two tasks: 

 Visualization (on page 139)  

Display of the data traffic sent via PRP. The information is displayed separately for the two 

network adapters used. 

 Configuration (on page 140) 

Assignment of the configured network adapter. 

 

Note: This dialog is only available in English. 

The PRPCfgDiag.exe program is supplied with zenon. 

You can find this software on your computer in the C:\Program Files (x86)\Common 

Files\COPA-DATA\STARTUP folder. 

REQUIREMENTS 

The PRP Configuration and Diagnostic Tool needs the following for operation or configuration: 
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 Two network adapters that are combined into a bridge in the system settings. 

Note: In this bridge, only the two network adapters that are used for PRP communication 

can be configured. Other network adapters must not be included in this bridge. 

 The CDPrpFlt driver must be installed in the operating system. 

  Information 

You can find information on the installation and necessary preparations in the 

system settings in the installation and configuration (on page 129) chapter. 

 
 

9.4.1 Statistics 

The data flow is visualized in the Statistics dialog. The setting is displayed separately for both LAN 

adapters. 

The flow of data is always recorded, even if the tool is not open. 

 

Note: This dialog is only available in English. 

Parameter Description 

Send count Display of the Ethernet frame sent. 

Receive count Display of the Ethernet frame received. 

Error count Display of corrupt PRP frames. 

Possible cause could be, for example, a mix-up of 

LAN A and LAN B (at any PRP nodes). 

Mismatch count Display of PRP frames received/sent differently if 

the network data traffic of the two LAN adapters 

differs from one another. 

Link status Status of the network card: 
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Parameter Description 

 Active 

PRP-Supervision frames are received 

correctly for the respective (LAN_A or 

LAN_B). 

 Inactive 

No PRP Supervision frames are received 

within the past two seconds. There is no 

PRP station in the network or there is an 

error. 

Configuration Opens the configuration dialog (on page 140). 

Exit Closes the program. 

Note: The data continues to be recorded. 

 
 

9.4.2 Configuration 

The following is carried out in the Configuration dialog: 

 Network adapter is assigned by means of a drop-down list. 

The content of the drop-down list is based on the network settings. 

You can find further information in the installation and configuration (on page 129) chapter. 

 The multicast MAC address is visualized 

 Error messages from the network adapter configuration are visualized in an output window 
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Attention 

The computer must be restarted after changes to the configuration have been 

made. 

Note: This dialog is only available in English. 

Parameters Description 

Primary physical LAN Adapter Assignment of a network adapter to the physical 

connection to LAN A - for the primary LAN 

adapter. 

Attention: the assignment to LAN A and LAN B 

cannot be mixed in a PRP network. 

In the drop-down list, the adapters that are 

included on the configured bridge are listed. 

You can find information on this in the installation 

and configuration (on page 129) chapter. 

Secondary physical LAN Adapter Assignment of a network adapter to the physical 

connection to LAN B - for the 

secondary/redundant LAN adapter. 

In the drop-down list, the adapters that are 

included on the configured bridge are listed. 

You can find information on this in the installation 

and configuration (on page 129) chapter. 

LAN_A/LAN_B Multicast MAC Multicast MAC address for PRP Supervision frames. 

This address for the communication in the network 

is preset and cannot be changed. 

Note: Ensure that all PRP nodes use the same 

multicast MAC address in your network. No 

network adapter is to use this MAC address for 

another purpose. 

The last byte can be configured in the input field. 

The input format for this entry is hexadecimal (hex). 

Error message Output window with error messages. 

OK Accepts all changes and switches to statistics dialog 

(on page 139). 

Cancel Discards all changes and switches to statistics 
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Parameters Description 

dialog (on page 139). 

Attention: In the PRP communication network, the original Ethernet frames are supplemented by 

additional information (on OSI Layer 2), which is different in LAN A and LAN B. Mixing up the 

assignment of network cards (or cables) to LAN A and LAN B leads to errors in the Ethernet 

communication throughout the entire PRP network. 
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